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Introduction

Blazent enables IT executives to operate their businesses more efficiently and more 
profitably by optimizing their information technology resources. Blazent IT 
Intelligence Software delivers complete, consistent and real-time information to 
allow enterprises with a significant investment in information technology to 
quickly reduce costs, control complexity and improve service levels. 

Blazent IT Intelligence Software can be used to drive a number of major IT 
business initiatives, such as server optimization, software license rationalization, 
desktop migration, asset intelligence, security, and help desk integration. For more 
information please visit us at http://www.blazent.com. 

About IT Intelligence Software Product 

Documentation

The Blazent IT Intelligence Software product documentation includes two 
manuals and one online help system. Each of these documents is updated as 
needed, with late-breaking changes included in a set of release notes. 
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Introduction
Installation Guide 

The Blazent Installation Guide is intended for IT administrators and professional 
services personnel who install and configure Blazent IT Intelligence Software. It is 
designed to be used in conjunction with the appropriate installation and 
configuration manuals for your existing hardware and software.  

Administration Guide

The Blazent Administration Guide is intended for IT administrators who are charged 
with maintaining the Blazent IT Intelligence Software system. This manual 
includes information on adding new users and hardware, categorizing existing 
hardware and software, administration tools, and troubleshooting.

Analytics Online Help 

Blazent Analytics Online Help is intended for IT professionals who view Blazent IT 
Intelligence Software data through the Blazent Analytics web interface. This online 
help system provides information on the content of each of the built-in reports, as 
well as information on how to manipulate these reports to gain new insight into the 
data.

Blazent Administration Online Help

Blazent Administration Online Help is intended for users of Blazent Administration, 
including IT administrators and Professional Service people. This context-
sensitive online help system provides information on each part of the Blazent 
Administration tool.

Note: Please follow the configuration recommendations that are 
suggested in this guide. If specific instructions do not appear for a 
particular configuration step or option, default values are acceptable.
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Viewing Product Documentation Online
Viewing Product Documentation Online

You can view Blazent IT Intelligence Software manuals on any computer that has 
Acrobat Reader installed. Blazent Analytics Online Help is available by clicking the 
? button within the Blazent Analytics interface.

Technical Support

The Blazent Technical Support organization provides support services for all 
current releases of Blazent products. Support staff are available Monday through 
Friday from 8:00am to 5:00pm Pacific Time, excluding holidays.

You can contact the Support group by phone at (650) 286 5588, or by e-mail at 
support@blazent.com.

For more information on Support services, see Appendix C,  “Technical Support.”

Contacting Blazent

Blazent
1820 Gateway Drive, Suite 200
San Mateo, CA 94404

650.286.5500 (Main)
650.286.1956 (Fax) 

http://www.blazent.com/
Blazent Confidential  3
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Overview

Blazent IT Intelligence Software allows users to automatically collect data about 
enterprise-wide hardware and software resources. IT professionals can use this 
information to:

! optimize the way that servers are used within the organization or across the 
enterprise.

! determine the appropriate number and type of software licenses that should 
be purchased based on application usage and utilization.

! understand the resources and cost that are required to upgrade users to a new 
software package or version.

! plan software and hardware upgrade strategies that minimize impact on 
service levels.

! understand the differences in hardware and software utilization between 
different employee groups.

! track the amount of time that different software applications are used by 
employees and the amount of IT resources that these applications consume.

! discover all hardware assets that are connected to a specific network or to your 
entire network.
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Chapter 1: Overview
System Architecture

As Figure 1, on page 11, illustrates, Blazent IT Intelligence Software consists of the 
following major components:

! Blazent Collectors

! Blazent Intelligence Platform

! Blazent Analytics

Each component is described in detail in the sections that follow. 

Blazent Collectors

Blazent Collectors bring data from individual IT resources, such as personal 
computers (PCs), servers, and printers, into the Blazent Intelligence Platform. 
Blazent collectors include Blazent Agents and Blazent Discovery.

Blazent Agents

Blazent Agents (1a) are lightweight applications (~3-5 MB) that are deployed on 
client machines and servers for which IT needs data. Blazent Agents unobtrusively 
gather detailed information about hardware and software assets that are installed 
on a machine, including:

! Detailed vendor and version information about all hardware and software 
components. 

! Software and hardware usage information, such as whether a hardware 
component is being used at all.

! Software utilization information, such as the number of minutes that software 
applications are open and actively used by a particular user.

! Hardware utilization information, such as the amount of memory and CPU 
power that is used over time.
Blazent Confidential 6
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System Architecture
When a new version of Blazent Agent software becomes available, administrators 
can use an optional software distribution module (PowerUpdate) or third-party 
products such as SMS and CA Unicenter. These solutions allow administrators to 
automatically deploy the updated software version to all Blazent Agents in the 
organization. Installation and configuration details for the PowerUpdate software 
distribution module are included in this guide and the Installation Guide. 

Blazent Discovery

Blazent Discovery (1b) identifies and tracks all assets that are connected to your 
network, including PCs and servers that do not have Blazent Agents installed, 
printers, network equipment, and other peripherals. Each instance of Discovery 
uses the NMAP utility to rapidly scan a unique range of IP addresses. Each scan 
returns information about the hosts that are available at those addresses, including:

! Host name

! IP address

! MAC address and vendor

! Operating system and service pack

! Domain name

Blazent Intelligence Platform

Blazent Intelligence Platform compiles data from Blazent Collectors and other third-
party data sources and processes it so that it can be used in Blazent Analytics 
reports. Blazent Intelligence Platform consists of the following components:
Blazent Confidential  7
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Chapter 1: Overview
Collection Server

The Collection Server (2) collects data directly from Blazent Agents and Blazent 
Discovery with XML messages over HTTP. Depending on the number of 
deployed Blazent Collectors, one or more Collection Servers can be installed 
within an organization.

Blazent Administration (3) allows administrators to maintain the IT Intelligence 
Software installation, view the status of all deployed Collection Servers, and 
configure rules that specify:

! Information about purchased software licenses.

! Available software packages.

! Software package, application, and hardware categorization rules.

Collection Database

The Collection Database (4) stores all of the raw data that is collected by the 
Collection Server.

Blazent Software Catalog

The Blazent Software Catalog (4) contains a list of commercially available software 
items and packages. Each software item is mapped to the appropriate package, and 
each software package is assigned to a category. When a Blazent Agent discovers a 
new software item, it is assigned to a package and category based on the contents 
of the catalog. 

Blazent regularly updates the software catalog with new application and package 
names and categories. In addition, Blazent Professional Services can customize the 
software catalog for your organization by altering the package or category 
mappings. 
Blazent Confidential 8
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System Architecture
Blazent Connectors

Blazent Connectors (5) bring in data from third party data sources, such as Human 
Resource Management Systems (HRMS) and IT Operations databases, and make it 
available to the Blazent Intelligence Platform. For more information on 
implementing Connectors in your installation, contact Blazent Professional 
Services.

Data Integration Services

Data Integration Services (6) cleanses, filters, maps, and categorizes the raw data from 
the Blazent Collection Database and from Blazent Connectors according to 
customizable rules. This component makes use of a product from Embarcadero 
and is managed through the Embarcadero Console administrative tool. 

Data Warehouse

The Data Warehouse (7) stores all of the optimized data that was processed by Data 
Integration Services. This refined data is then used in Blazent Analytics to produce 
dynamic reports. 

Analytics Server

The Analytics Server (8) uses the processed data from the Data Warehouse to provide 
intelligent reports for CIOs and other IT executives and managers. This 
component makes use of a product from MicroStrategy and is managed through 
the MicroStrategy Desktop administrative tool. 
Blazent Confidential  9
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Chapter 1: Overview
Blazent Analytics

Blazent Analytics (9) is a web application that allows IT professionals to understand 
the hardware and software deployments in their organization, including where they 
are located, if they are actually being used, and how they are being utilized. This 
application includes pre-built reports, and allows custom reports to be created by 
the user. Blazent Analytics includes the following pre-built report categories:

! Blazent CIO. Executive overviews of the software and hardware needs of your 
organization.

! Blazent Servers. Reports on the servers in your organization.

! Blazent PCs. Reports on the personal computers used by individuals in your 
organization.

! Blazent Help Desk. Reports that profile server and software usage that are 
tailored for the Help Desk environment.

! Blazent Assets. Reports that provide information about all hardware on your 
network, including items without installed Blazent Agents.

For more information, see Chapter 6, “Using Blazent Analytics,” or use the built-
in Blazent Analytics online help.
Blazent Confidential 10
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System Architecture
Figure 1:  Blazent IT Intelligence Software System Architecture
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Administrative Tools

This chapter includes information about the administrative tools that allow you to 
configure and maintain your Blazent IT Intelligence Software implementation. 
These tools include:

! Blazent Administration. Allows administrators to control the Collection Server 
and configure rules for data categorization and utilization filtering.

! Embarcadero Console. Allows administrators to control Data Integration 
Services and data-mapping tasks. 

! Configuration Files (servers.csv, users.csv, ip-locations.csv, OsCleansing.xml, 

OSNameCleansing.xml, AssetCategorization.xml). Allow administrators to define 
additional mapping, data cleansing, and categorization rules.

! Oracle DBA Studio (8i) and Oracle Enterprise Manager Console (9i). Allows 
administrators to control the Collection and Data Warehouse database 
instances.

! MicroStrategy Desktop. Allows administrators to control and configure the 
Analytics Server.

! PowerUpdate Controller. Allows administrators to control and configure the 
PowerUpdate Server, if installed.

! Blazent Database Diagnostics - bzbs_run_diagnostics.bat. A database diagnostic 
tool that allows administrators to verify the integrity of the Collection and 
Data Warehouse databases. 
Blazent Confidential 13
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Chapter 2: Administrative Tools
Blazent Administration

Blazent Administration is a web-based application that you can use to control the 
Collection Server and configure rules for data categorization and utilization 
filtering.

Opening Blazent Administration

To open Blazent Administration, access the following URL:
http://<CollectionServerName>:8080/blazentadmin/

where CollectionServerName is the name of a Collection Server. Blazent 
Administration opens to the screen displayed in Figure 2, on page 15.

Navigating Blazent Administration

Blazent Administration is split into six areas. You can navigate directly to each area 
by clicking the appropriate link in the left side bar:

! Server Status. Allows you to view the status of Collection servers in your 
Blazent IT Intelligence Software configuration. 

! Software Catalog Import. Allows you to import a new software catalog into 
your Data Warehouse.

! Software License Management. Allows you to manage the list of software 
licenses that have been purchased by your organization.

! Hardware Categorization. Allows you to manage rules that specify how 
hardware should be categorized in Blazent Analytics. 

! Utilization Tracking. Allows you to track utilization data for specific 
applications, or for applications that are consuming the most resources.

! Blazent Analytics. Provides a direct link to the Blazent Analytics log in screen.

Each area is further described in the sections that follow. For more information, 
refer to the Blazent Administration context-sensitive online help system, available 
by clicking the ? button in any screen.
Blazent Confidential 14
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Blazent Administration
Server Status

The Server Status area of Blazent Administration (Figure 2) allows you to view the 
status of all Collection Servers in your configuration. In a single Collection Server 
configuration, this list is pre-populated with information about that server. In a 
multiple Collection Server configuration, you must manually register each 
additional server.

For more information, refer to the Blazent Administration context-sensitive online 
help system, available by clicking the ? button in any screen.

Figure 2:  Blazent Administration: Server Status
Blazent Confidential  15
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Chapter 2: Administrative Tools
Software Catalog Import

The Software Catalog Import wizard allows you to update the software package and 
item catalog that is built into your Blazent IT Intelligence Software application (see 
“Blazent Software Catalog,” on page 8). 

Blazent regularly updates the software catalog with new application and package 
names and categories. In addition, Blazent Professional Services can customize the 
software catalog for your organization by altering the package or category 
mappings. You can use the Software Catalog Import wizard to merge these updates 
with the catalog that was originally installed with your Blazent IT Intelligence 
Software application. The wizard allows you to review the old and new software 
mappings, and decide which to keep.

Figure 3, on page 17 displays the flow of operation of the Software Catalog Import 
wizard. The wizard runs by loading a catalog import file into a workspace on the 
Collection Server. When the catalog import file is loaded, the wizard compares the 
data in the new file with the contents of the existing catalog:

! All software items and packages that did not previously exist in the catalog are 
identified as entries that should be automatically added.

! All software items and packages that previously existed in the catalog but that 
were not customized for your organization are identified as entries that should 
be automatically updated.

! All software items and packages that previously existed in the catalog and were 
customized for your organization are flagged for review in the wizard.

The Software Catalog Import wizard then allows you to review the flagged entries, 
section by section, in order of mapping type. Once all flagged entries have been 
reviewed, you can install the catalog updates in the Collection database. 

For more information, refer to the Blazent Administration context-sensitive online 
help system, available by clicking the ? button in any screen.
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Blazent Administration
Figure 3:  Software Catalog Import Wizard Flow
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Chapter 2: Administrative Tools
Software License Management

The Software License Management area of Blazent Administration (Figure 4 on 
page 18) allows you to manage the list of software licenses that have been 
purchased by your organization. You can add, edit, and delete software licenses 
from this list.

For more information, refer to the Blazent Administration context-sensitive online 
help system, available by clicking the ? button in any screen.

Figure 4:  Blazent Administration: Software License Management
Blazent Confidential 18
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Blazent Administration
Hardware Categorization

The Hardware Categorization area of Blazent Administration (Figure 5, on page 20) 
allows you to manage the categorization rules that are applied to hardware items. 
These rules determine the category to which a hardware item is assigned.  

You can define hardware categorization rules based on the following types of 
information:

! Class. The hardware classification returned by the operating system. For 
example, when memory capacity is collected, the class name returned by the 
operating system is "MEM." 

! Class Category. The hardware classification returned by the operating system 
in a more user-friendly format. In the memory capacity example from above, 
the class category is “memory.” Most hardware categorization rules use this 
rule class.

! Description. This class of rule specifies that all hardware items that match a 
particular description should be assigned to a certain category.

! Friendly Name. The device name (for example, LITEON DVD-ROM 
LTD163). 

! Manufacturer. This class of rule specifies that all hardware items that are built 
by a particular manufacturer should be assigned to a certain category. For 
example, all hardware made by Linksys could be assigned to a “Network 
Equipment” category.

For more information, refer to the Blazent Administration context-sensitive online 
help system, available by clicking the ? button in any screen.

Note: Unlike hardware items, software packages and applications 
are categorized with a built-in catalog. See “Software Catalog 
Import,” on page 16 for more information.
Blazent Confidential  19

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Chapter 2: Administrative Tools
Figure 5:  Blazent Administration: Hardware Categorization
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Blazent Administration
Utilization Tracking

The Utilization Tracking area of Blazent Administration (Figure 6, on page 22) 
allows you to track utilization data for software that meets one of the following 
conditions:

! Threshold settings. Data is tracked if it exceeds threshold values that you 
specify. These settings allow you to quickly determine which software 
applications are consuming the most resources.

! Specified software. Data is tracked if it is for software items or packages that 
you specify in the Specified Software list. This list allows you to track 
utilization for software applications and packages that are particularly 
important to your organization.

For more information, refer to the Blazent Administration context-sensitive online 
help system, available by clicking the ? button in any screen.

Blazent Analytics

The Blazent Analytics area of Blazent Administration provides a direct link to the 
Blazent Analytics log in screen. For more information about Blazent Analytics, see 
Chapter 6, “Using Blazent Analytics.”
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Chapter 2: Administrative Tools
Figure 6:  Blazent Administration: Utilization Tracking
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Embarcadero Console
Embarcadero Console

The Embarcadero Console is an application that administrators can use to control 
Data Integration Services and all data-mapping tasks. To access this application 
from the Data Integration Services machine, open the Start menu and choose 
Programs > Embarcadero DTStudio 2.1.1 > Embarcadero DT Console 2.1.1 > DT 
Console 2.1.1.

Built-in Data Integration Services tasks and task chains are automatically installed 
with Data Integration Services and can be viewed and executed in Embarcadero 
Console once you have logged into your Data Integration Server (DT/Engine) 
(see Figure 7). These tasks and task chains are used to cleanse and map the data in 
the Collection Database to make it ready for use in Blazent Analytics. 

In most installations, the only tasks or task chains that should be scheduled to run 
are:

! initialize_all_tasks. This task chain must be run once after Data Integration 
Services is first installed. This task chain runs all data processing tasks and 
loads the Data Warehouse for the first time.

! scheduled_tasks. This task chain processes new data and updates the Data 
Warehouse. Blazent recommends that this task chain be scheduled to run at 
least once a day (see “Scheduling a Task or Task Chain,” on page 26). This 
task chain should not run concurrently with discovery_tasks or data_cleansing.

Note: Embarcadero does not currently offer support for running 
their products remotely through Windows Terminal Services. If you 
wish to administer your DT/Engine from a remote machine, install 
another instance of DT/Console on the remote machine and 
configure it to connect to the DT/Engine on the Data Integration 
Services server. 

See “Installing DT/Console on Remote Administration Machines,” 
on page 53 of the Installation Guide for details.
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Chapter 2: Administrative Tools
! discovery_tasks. This task chain performs all data cleansing processes for 
Blazent Discovery. Schedule this task chain to run on an interval based on 
how often Blazent Discovery collects new data. This task chain should not run 
concurrently with scheduled_tasks or data_cleansing.

! AnalyzeCollectionDB. This task optimizes the performance of the Collection 
Database. Schedule this task chain to run once a week on a non-work day 
(such as Saturday).

! AnalyzeWarehouseDB. This task optimizes the performance of the Data 
Warehouse. Schedule this task chain to run once a week on a non-work day 
(such as Saturday). To make the best use of this task, run it for the first time 
only after you have run several reports in Blazent Analytics.

! (Optional) data_cleansing. This task chain improves the performance of the 
sync_all task. Although optional, Blazent recommends that you schedule this 
task chain every two hours, but this task chain should not run concurrently 
with discovery_tasks or scheduled_tasks. For example, if scheduled_tasks runs 
every day at 10 PM, then data_cleansing should run at 9 PM and 11 PM.

! purgeUtilDataHourly. This task deletes outdated hourly utilization data from the 
Collection Database. Schedule this task to run once a day after 
scheduled_tasks completes.

! purgeUtilDataMonthly. This task deletes outdated monthly utilization data from 
the Collection Database. Schedule this task to run on the first weekend of 
every month after scheduled_tasks completes.

Table 1, on page 27 describes the built-in tasks and task chains in detail.
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Embarcadero Console
Executing a Task or Task Chain

To execute a task or a task chain in Embarcadero Console, right-click the task or 
task chain and choose Start. This action executes this task or task chain 
immediately. 

Figure 7:  Embarcadero Console
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Chapter 2: Administrative Tools
Scheduling a Task or Task Chain

To schedule a task or a task chain to run on a recurring basis:

1. Right-click the task or task chain and choose New Schedule. This action opens 
the Schedule Properties dialog box.

2. In the Schedule Name text box, enter a name for the schedule that you are 
creating.

3. Select a Date and Time for the task or task chain to begin.

4. If you wish to schedule a recurring task or task chain:

a) Select Recurring Task.

b) Specify the interval in months, days, or any combination of hours, minutes 
and seconds.

c) If you wish to schedule an end date for the recurrence, enter the 
appropriate end date and time.

5. Click OK. A message appears that says the schedule was added successfully, 
and a schedule icon appears under the task or task chain. The task or task 
chain will run automatically based on the schedule that you created as long as 
the DT/Engine is running.  

Viewing Task Execution History and Logs

To view the execution history for a task or task chain:

1. Select the task or task chain in the left pane, or choose the DT/Engine server 
icon if you wish to view all tasks and task chains at once.

2. Review the Status column for each task or task chain. 

3. Click on the History tab in the right pane. All completed or currently running 
task records associated with that task or task chain are displayed.

Note: In normal installations, the only tasks or task chains that 
should be scheduled on a recurring basis are those listed on Page 23.
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Embarcadero Console
To view the progress of a task or task chain you can also examine its associated log 
file. One log is created every time a task or task chain is executed. Log files are 
stored in the task or task chain directories in:

<install_dir>\Program Files\Embarcadero\DTStudio\DTEngine2.1.1\
logs\

Task and Task Chain Listings

Table 1 lists the task chains and tasks that are included with Data Integration 
Services.

Table 1: Data Integration Services Tasks and Task Chains
(1 of 15)

Task/Task Chain 

Name

Tasks Invoked Description

data_cleansing • load_cleansing_filters
• load_manufacturer_filters
• clean_package_manufacturer_

incremental
• clean_software_manufacturer_

incremental

A task chain that cleanses the 
manufacturer name value for 
software package, software, and 
hardware items. 

For example, similar manufacturer 
names such as Microsoft and 
Microsoft Corporation are 
recognized as one manufacturer 
instead of two.

Blazent recommends that you 
schedule this task chain every two 
hours, but this task chain should 
not run concurrently with 
discovery_tasks or scheduled_tasks. 
For example, if scheduled_tasks 
runs every day at 10 PM, then 
data_cleansing should run at 9 PM 
and 11 PM.
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Chapter 2: Administrative Tools
data_migration_
collection

• migrate_departments
• migrate_employee_positions
• migrate_hardware_entries
• migrate_hardware_items
• migrate_locations
• migrate_machine_categories
• migrate_machine_category_map
• migrate_machine_info
• migrate_machines
• migrate_os_entries
• migrate_os_families
• migrate_personnel_status
• migrate_software_entries
• migrate_software_items
• migrate_software_licenses_

purchased
• migrate_sw_package_items
• migrate_user_machine_profiles
• migrate_user_machines
• migrate_user_sessions
• migrate_users

This task chain is not used in V. 2.2.

data_migration_
warehouse

• migrate_dw_sw_util_month
• migrate_dw_sw_util_day
• migrate_dw_sw_util_hour
• migrate_dw_disk_storage_util_

month

This task chain is not used in V. 2.2.

Table 1: Data Integration Services Tasks and Task Chains
(2 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Embarcadero Console
discover_asset_mapping • load_asset_filters
• categorize_assets

A task chain that assigns each 
discovered asset to a specific type 
according to rules in the 
AssetCategorization.xml 
file. 

Default discovered asset type 
definitions include Server, PC, 
Wireless Device, Network Equipment, 
Printer, and Others.

Required external data 

sources

• AssetCategorization.xml

• AssetCategorization.dtd

See “Discovered Asset 
Categorization - 
AssetCategorization.xml,” on page 
51 for information.

discover_asset_mapping
_incremental

• load_asset_filters
• categorize_assets_incremental

A task chain that performs the 
same functionality as 
discover_asset_mapping, but for 
new discovered assets only.

Required external data 

sources

• AssetCategorization.xml

• AssetCategorization.dtd

See “Discovered Asset 
Categorization - 
AssetCategorization.xml,” on page 
51 for information.

Table 1: Data Integration Services Tasks and Task Chains
(3 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
discovery_tasks • load_asset_filters
• categorize_assets
• load_cleansing_filters
• load_manufacturer_filters
• clean_discovery_manufacturers
• load_operating_system_filters
• clean_discovery_os_name
• load_os_name_cleansing_filters
• os_name_cleansing
• clean_discovered_asset_model

A task chain that performs data 
cleansing and mapping for 
discovered assets.

This task chain should not run 
concurrently with scheduled_tasks 
or data_cleansing.

Required external data 

sources

• AssetCategorization.xml

• AssetCategorization.dtd

• OSCleansing.xml

• OSCleansing.dtd

• OSNameCleansing.xml

• OSNameCleansing.dtd

See “Configuration Files,” on page 
41 for information.

hardware_categorization • load_cleansing_filters
• load_manufacturer_filters
• load_hw_filters
• categorize_hardware

A task chain that assigns each 
hardware item to a specific type 
according to rules that are set in 
Blazent Administration. This task 
chain also cleanses hardware item 
data. See “Hardware 
Categorization,” on page 19 for 
details.

hardware_categorization
_incremental

• load_cleansing_filters
• load_manufacturer_filters
• load_hw_filters
• categorize_hardware_

incremental

A task chain that performs the 
same functionality as 
hardware_categorization, but for new 
hardware items only.

Table 1: Data Integration Services Tasks and Task Chains
(4 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Embarcadero Console
initialize_all_tasks • load_hw_filters
• categorize_hardware
• load_ip_range
• ip_location_mapping
• add_server_dimensions
• map_servers
• add_user_dimensions
• add_users
• map_users
• initialize
• load_manufacturer_filters
• load_cleansing_filters
• clean_package_manufacturers
• clean_software_manufacturers
• clean_discovery_manufacturers
• load_operating_system_filters
• clean_discovery_os_name
• load_os_name_cleansing_filters
• os_name_cleansing
• clean_discovery_asset_models
• sync_all

A task chain that rebuilds the 
Collection databasea and then 
populates the Data Warehouse. All 
existing data is deleted from the 
Collection database.

This task chain should only be run 
once when Blazent IT Intelligence 
Software is first installed. All 
subsequent data processing should 
be performed with the 
scheduled_tasks task chain.

Required external data 

sources

• AssetCategorization.xml

• AssetCategorization.dtd

• OSCleansing.xml

• OSCleansing.dtd

• OSNameCleansing.xml

• OSNameCleansing.dtd

• ip-locations.csv

• users.csv

• servers.csv

See “Configuration Files,” on page 
41 for information.

ip_loc_mapping • load_ip_range
• ip_location_mapping

A task chain that assigns each 
discovered asset to a physical 
location based on user-defined IP 
range - location mappings in the 
ip-locations.csv file. See 
“IP-Location Mapping - IP-
Location.csv,” on page 44 for 
information.

Table 1: Data Integration Services Tasks and Task Chains
(5 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
ip_loc_mapping_
incremental

• load_ip_range
• ip_location_mapping_

incremental

A task chain that performs the 
same functionality as 
ip_loc_mapping, but for new 
discovered assets only.

initialize_db • load_hw_filters
• load_manufacturer_filters
• load_cleansing_filters
• categorize_hardware
• initialize

A task chain that initializes the Data 
Warehouse without performing 
data mapping or cleansing.

scheduled_tasks • load_ip_range
• ip_location_mapping_

incremental
• add_user_dimensions
• add_users 
• map_users
• add_server_dimensions
• map_servers
• load_cleansing_filters
• load_manufacturer_filters
• clean_package_manufacturers_

incremental
• clean_software_manufacturers_

incremental
• load_hw_filters
• categorize_hardware_

incremental
• sync_all

A task chain that performs all data 
processing functions on new items 
and then calls the sync task to 
update the Data Warehouse.

This task chain should be 
scheduled to run at least once a day 
to keep the Data Warehouse and 
Blazent Analytics current with the 
latest data. This task chain should 
not run concurrently with 
discovery_tasks or data_cleansing.

Required external data 

sources

• ip-locations.csv

• users.csv

• servers.csv

See “Configuration Files,” on page 
41 for information.

Table 1: Data Integration Services Tasks and Task Chains
(6 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Embarcadero Console
server_mapping • add_server_dimensions
• map_servers

A task chain that maps server 
names to specific locations, 
departments, and roles based on 
entries in the servers.csv file. 

Required external data 

sources

• servers.csv

See “Server Mapping - 
Servers.csv,” on page 42 for 
information.

sync_db • load_hw_filters
• load_manufacturer_filters
• load_cleansing_filters
• categorize_hardware
• sync_all

A task chain that synchronizes the 
Data Warehouse without 
performing data mapping or 
cleansing.

um_add_users • add_user_dimensions
• add_users
• map_users

A task chain that maps users to 
specific names, departments, and 
job titles based on entries in the 
users.csv file. 

Required external data 

sources

• users.csv

See “User Mapping - Users.csv,” 
on page 43 for information.

Table 1: Data Integration Services Tasks and Task Chains
(7 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
add_server_dimensions add_server_dimensions A task that reads the 
servers.csv file and checks that 
all locations, departments, server 
functions, and roles already exist in 
the Data Warehouse. If they do not, 
the new data is added to the 
appropriate tables.

Required external data 

sources

• servers.csv

See “Server Mapping - 
Servers.csv,” on page 42 for 
information.

add_user_dimensions add_user_dimensions A task that reads the users.csv 
file and checks that all locations, 
departments, and job titles already 
exist in the Data Warehouse. If they 
do not, the new data is added to the 
appropriate tables.

Required external data 

sources

• users.csv

See “User Mapping - Users.csv,” 
on page 43 for information.

add_users add_users A task that reads the users.csv 
file and checks that all listed users 
exist in the user table. If they do 
not, the new users are added.

Required external data 

sources

• users.csv

See “User Mapping - Users.csv,” 
on page 43 for information.

Table 1: Data Integration Services Tasks and Task Chains
(8 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
Blazent Confidential 34

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Embarcadero Console
AnalyzeCollectionDB AnalyzeCollectionDB A task that optimizes the 
performance of the Collection 
Database. Schedule this task chain 
to run once a week on a non-work 
day (such as Saturday).

AnalyzeWarehouseDB AnalyzeWarehouseDB A task that optimizes the 
performance of the Data 
Warehouse. Schedule this task 
chain to run once a week on a non-
work day (such as Saturday).

categorize_assets categorize_assets Assigns all discovered assets that 
are listed in the 
discovered_asset table to a 
category according to the rules that 
are stored in the DT/Engine 
memory.

categorize_assets_
incremental

categorize_assets_incremental A task that performs the same 
functionality as categorize_assets, 
but for new discovered assets only.

categorize_hardware categorize_hardware Assigns all hardware items that are 
listed in the hardware_items 
table to a category according to the 
rules that are stored in the DT/
Engine memory.

categorize_hardware_
incremental

categorize_hardware_incremental A task that performs the same 
functionality as 
categorize_hardware, but for new 
hardware items only.

Table 1: Data Integration Services Tasks and Task Chains
(9 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
clean_discovery_
manufacturers

clean_discovery_manufacturers A task that cleanses the 
manufacturer field in the 
discovered_assets table. The 
cleansing process both attempts to 
assign manufacturers to empty 
fields, and ensures that 
manufacturer field values use a 
consistent format.

clean_hardware_
manufacturers

clean_hardware_manufacturers A task that cleanes the 
manufacturer field in the 
hardware_items table. The 
cleansing process both attempts to 
assign manufacturers to empty 
fields, and ensures that 
manufacturer field values use a 
consistent format.

clean_hardware_
manufacturers_
incremental

clean_hardware_manufacturers_
incremental

A task that performs the same 
functionality as 
clean_hardware_manufacturers, but 
for new hardware items only.

clean_package_
manufacturers

clean_package_manufacturers A task that cleanses the 
manufacturer field in the 
sw_package_items table. The 
cleansing process both attempts to 
assign manufacturers to empty 
fields, and ensures that 
manufacturer field values use a 
consistent format.

Table 1: Data Integration Services Tasks and Task Chains
(10 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Embarcadero Console
clean_software_
manufacturers

clean_software_manufacturers A task that cleanses the 
manufacturer field in the 
software_items table. The 
cleansing process both attempts to 
assign manufacturers to empty 
fields, and ensures that 
manufacturer field values use a 
consistent format.

initialize initialize A task that calls the database PL/
SQL function to initalize the Data 
Warehouse.

ip_location_mapping ip_location_mapping A task that assigns all assets in the 
discovered_assets table to a 
physical location according to the 
IP address of the asset and the IP 
range - location mappings that are 
stored in the DT/Engine memory.

ip_location_mapping_
incremental

ip_location_mapping_
incremental

A task that performs the same 
functionality as ip_location_mapping, 
but for new discovered assets only.

load_asset_filters load_asset_filters A task that loads the DT/Engine 
memory with discovered asset 
categorization rules from the 
AssetCategorization.xml 
file. 

Required external data 

sources

• AssetCategorization.xml

See “Discovered Asset 
Categorization - 
AssetCategorization.xml,” on page 
51 for information.

Table 1: Data Integration Services Tasks and Task Chains
(11 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
load_cleansing_filters load_cleansing_filters A task that loads the DT/Engine 
memory with manufacturer name 
cleansing rules from the 
bzc_data_cleaning file.

load_hw_filters load_hw_filters A task that loads the DT/Engine 
memory with hardware item 
categorization rules from the 
admin_category_ruleset 
table in the Collection Database. 
The rules in this table are defined in 
the Blazent Administration user 
interface. See “Hardware 
Categorization,” on page 19 for 
information.

load_ip_range load_ip_range A task that loads the ip-
locations.csv file into the 
DT/Engine.

Required external data 

sources

• ip-locations.csv

See “IP-Location Mapping - IP-
Location.csv,” on page 44 for 
information.

load_manufacturer_
filters

load_manufacturer_filters A task that loads the contents of 
the bzc_manufacturers table 
into the DT/Engine. This list is 
used during data cleansing to 
provide possible entries for items 
without a known manufacturer.

Table 1: Data Integration Services Tasks and Task Chains
(12 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Embarcadero Console
map_servers map_servers A task that reads the 
servers.csv file and uses that 
information to update the 
machine_info and 
machine_category_map tables 
with the appropriate machine 
names, locations, and departments.

Required external data 

sources

• servers.csv

See “Server Mapping - 
Servers.csv,” on page 42 for 
information.

map_users map_users A task that reads data from the 
user_machines table and maps 
the data to the appropriate user in 
the user table.

migrate_departments migrate_departments This task is not used in V. 2.2.

migrate_dw_disk_
storage_util_month

migrate_dw_disk_storage_util_
month

This task is not used in V. 2.2.

migrate_dw_sw_util_day migrate_dw_sw_util_day This task is not used in V. 2.2.

migrate_dw_sw_util_
hour

migrate_dw_sw_util_hour This task is not used in V. 2.2.

migrate_dw_sw_util_
month

migrate_dw_sw_util_
month

This task is not used in V. 2.2.

migrate_employee_
positions

migrate_employee_positions This task is not used in V. 2.2.

migrate_hardware_
entries

migrate_hardware_entries This task is not used in V. 2.2.

Table 1: Data Integration Services Tasks and Task Chains
(13 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
migrate_hardware_items migrate_hardware_items This task is not used in V. 2.2.

migrate_locations migrate_locations This task is not used in V. 2.2.

migrate_machine_
categories

migrate_machine_categories This task is not used in V. 2.2.

migrate_machine_
categories_map

migrate_machine_categories_
map

This task is not used in V. 2.2.

migrate_machine_info migrate_machine_info This task is not used in V. 2.2.

migrate_machines migrate_machines This task is not used in V. 2.2.

migrate_os_entries migrate_os_entries This task is not used in V. 2.2.

migrate_os_families migrate_os_families This task is not used in V. 2.2.

migrate_personnel_
status

migrate_personnel_status This task is not used in V. 2.2.

migrate_software_entries migrate_software_entries This task is not used in V. 2.2.

migrate_software_items migrate_software_items This task is not used in V. 2.2.

migrate_software_
licenses_purchased

migrate_software_licenses_
purchased

This task is not used in V. 2.2.

migrate_sw_package_
items

migrate_sw_package_items This task is not used in V. 2.2.

migrate_user_machine_
profiles

migrate_user_machine_profiles This task is not used in V. 2.2.

migrate_user_machines migrate_user_machines This task is not used in V. 2.2.

migrate_user_sessions migrate_user_sessions This task is not used in V. 2.2.

migrate_users migrate_users This task is not used in V. 2.2.

Table 1: Data Integration Services Tasks and Task Chains
(14 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Configuration Files
Configuration Files

Some configuration tasks are also performed by editing rules within files. The 
following files are described in this section:

! Server mapping (servers.csv)

! User mapping (users.csv)

! IP-location mapping (ip-location.csv)

! OS data cleansing (OSCleansing.xml and OSNameCleansing.xml)

! Discovered Asset categorization (AssetCategorization.xml)

purgeUtilDataHourly purgeUtilDataHourly A task that deletes outdated hourly 
utilization data from the Data 
Warehouse. Schedule this task to 
run once a day after 
scheduled_tasks completes. 

purgeUtilDataMonthly purgeUtilDataMonthly A task that deletes outdated 
monthly utilization data from the 
Data Warehouse. Schedule this task 
to run on the first weekend of every 
month after scheduled_tasks 

completes.

reload reload A task that calls the 
RELOAD_ALL Data Warehouse 
ETL function.

sync_all sync_all A task that calls the SYNC_ALL 
Data Warehouse ETL function.

Table 1: Data Integration Services Tasks and Task Chains
(15 of 15)

Task/Task Chain 

Name

Tasks Invoked Description
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Chapter 2: Administrative Tools
Server Mapping - Servers.csv

The servers.csv file allows administrators to map server names to their 
physical location, department, server function, and role. To add new servers to this 
file:

1. Open the servers.csv file in <install_directory>\
\BlazentIntegrationServices\tasks\data . This file contains the 
list of new servers that should be added to Blazent IT Intelligence Software.

2. To define a server, enter the following information on a single line, with each 
item separated by a comma:

!  Machine Name

!  Location (City)

!  Location (State)

!  Location (Country)

!  Department

!  Function (The primary application function of the server. For example, 
database server, DNS server, file server, and so on.)

!  Role (The role that the server plays in your organization. For example, 
Test, Development, Production, and so on.)

If a field is not relevant, use a blank space in place of the field. For example:
TRON,Toronto, ,Canada,Product Development,Database 
Server,Production

3. Stop and restart the Embarcadero DT/Engine and service:

a) Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e stop

b) Use the Windows Services control panel to restart the DT/Engine 
service.

c) Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e start
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Configuration Files
4. Run the scheduled_tasks task chain in the Embarcadero Console to add the 
new servers to your Data Warehouse.

5. Restart the Analytics Server to refresh Blazent Analytics with the new data.

User Mapping - Users.csv

The users.csv file allows administrators to map users to their computers. To 
add new users to this file:

1. Open the users.csv file in 
<install_directory>\BlazentIntegrationServices\tasks\dat
a . This file contains the list of new users that should be added to Blazent IT 
Intelligence Software.

2. To define a user, enter the following information on a single line, with each 
item separated by a comma:

! Last Name

! First Name

! Logon Name

! Job Title

! Location (City)

! Location (State)

! Location (Country)

! Department

If a field is not relevant, use a blank space in place of the field. For example:
Broquet,Alex,abroquet,Manager,Toronto, ,Canada,Product Development

3. Stop and restart the Embarcadero DT/Engine and service:

a) Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e stop

b) Use the Windows Services control panel to restart the DT/Engine 
service.
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Chapter 2: Administrative Tools
c) Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e start

4. Run the scheduled_tasks task chain in the Embarcadero Console to add the 
new users to your Data Warehouse.

5. Restart the Analytics Server to refresh Blazent Analytics with the new data.

IP-Location Mapping - IP-Location.csv

The ip-location.csv file allows administrators to map IP address ranges to 
physical locations for discovered assets. This file is located in the 
<install_dir>\BlazentIntegrationServices\tasks\data directory. 
To add new IP ranges to this file:

1. Open the ip-location.csv file in <install_dir>\
BlazentIntegrationServices\tasks\data. This file contains the 
list of IP address range - location mappings for discovered assets.

2. To define an IP address range, enter the following information on a single line, 
with each item separated by a comma:

! Range Start

! Range End

! Location (City)

! Location (State)

! Location (Country)

If a field is not relevant, use a blank space in place of the field. For example:
10.25.200.1,10.25.1.255,Toronto, ,Canada

For a sample ip-location.csv file, see <install_dir>\
BlazentIntegrationServices\tasks\data\ip-location-
example.csv
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3. Stop and restart the Embarcadero DT/Engine and service:

a) Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e stop

b) Use the Windows Services control panel to restart the DT/Engine 
service.

c) Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> <port> 
-e start

4. Run the scheduled_tasks task chain in the Embarcadero Console to add the 
new IP location mappings to your Data Warehouse.

5. Restart the Analytics Server to refresh Blazent Analytics with the new data.

OS Data Cleansing - OSCleansing.xml and 

OSNameCleansing.xml

The OSCleansing.xml and OSNameCleansing.xml files allow 
administrators to add or modify rules for cleansing operating system names for 
discovered assets. These files are located in the 
<install_dir>\BlazentIntegrationServices\tasks\data directory:

! OSCleansing.xml is used to populate the OS Asset Platform field for 
all discovered assets. This field can be assigned a value of Windows, Unix, or 
Other.

! OSNameCleansing.xml is used to populate the Asset Operating 
System field for all discovered assets. This field specifies the exact operating 
system and patch that was found through Discovery.
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Chapter 2: Administrative Tools
OSCleansing.xml Format and Parameters

OSCleansing.xml has the following format:
<FilterList>

<Filter>
<Action>Modify</Action>
<Pattern><OS_FAMILY>...</OS_FAMILY></Pattern> 
<CaseSensitive>...</CaseSensitive> 
<ElementList> 

<Element> 
<Name>OS_NAME</Name> 
<Value>...</Value> 
<Desc>...</Desc> 

</Element>
...

</ElementList> 
</Filter>
...

</FilterList>

OS cleansing rules are defined by applying regular expressions to the OS_FAMILY 
field that was returned by Discovery. The OS_FAMILY field typically contains a 
substring that identifies the operating system type of the relevant discovered asset. 

To add a new cleansing rule, add a filter to the filter list and specify values for the 
XML tags described in Table 2. 

Note: If you make a change to OSCleansing.xml you must stop 
and restart the Embarcadero DT/Engine for the changes to take 
effect. To do so:

1. Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e stop

2. Use the Windows Services control panel to restart the DT/
Engine service.

3. Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e start
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Table 2: OSCleansing.xml Tag Descriptions

Tag Name Description

<Action> Specifies how the rule should be executed:

• Modify. This action updates the value of items that match the search 
pattern. This is the most commonly used action and is used for every 
categorization rule to assign categories or groups to an item.

• Remove. This action prevents matching items from being added to the 
Data Warehouse. This action is rarely used, but can be implemented to 
filter out specific items from being stored. For example, by default there 
is a filter rule that prevents zero-byte size files from being added.

<Pattern> A regular expression that specifies the string that should be matched in 
the OS_FAMILY field returned by Discovery. This regular expression 
should always be wrapped in <OS_FAMILY> tags.

For example, <OS_FAMILY>.*Mac OS.*</OS_FAMILY> would return 
all strings with one or more characters (including spaces), followed by 
“Mac OS” followed by one or more characters (including spaces). 

The rules for regular expressions are described at http://java.sun.com/
j2se/1.4.2/docs/api/java/util/regex/Pattern.html.

CaseSensitive Specifies whether this rule is case sensitive (True) or not (False). 

For example, if the rule is not case sensitive and.*Mac OS.* is the 
regular expression in your <Pattern> tag, both “Mac OS” and “mac os” 
would match the rule. If the rule is case sensitive, only “Mac OS” would 
match.

Element List The list of parameters that should be assigned a value for all discovered 
assets that match the pattern rule. The element list generally only contains 
a single element for the OS_NAME parameter.

Element > Name The name of the parameter that should be modified for this discovered 
asset. This value is always OS_NAME.

Element > Value The value that should be assigned to OS_NAME for this filter element. 
Built-in values include Windows, Unix, and Other. 

Element > Desc (Optional) A space for comments that describe the purpose of the rule.
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Chapter 2: Administrative Tools
OSNameCleansing.xml Format and Parameters

OSNameCleansing.xml has the following format:
<FilterList>

<Filter>
<Action>Modify</Action>
<Pattern><MAC>...</MAC></Pattern> 
<CaseSensitive>...</CaseSensitive> 
<ElementList> 

<Element> 
<Name>OS_TYPE</Name> 
<Value>...</Value> 
<Desc>...</Desc> 

</Element>
...

</ElementList> 
</Filter>
...

</FilterList>

OS name cleansing rules are defined by applying regular expressions to the MAC 
field that was returned by Discovery. This field contains the discovered MAC 
address for the discovered asset. The MAC address typically contains a substring 
that identifies the discovered asset vendor, which can then be used to determine 
the OS type value.
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To add a new cleansing rule, add a filter to the filter list and specify values for the 
XML tags described in Table 3. 

Note: If you make a change to OSNameCleansing.xml you must 
stop and restart the Embarcadero DT/Engine for the changes to take 
effect. To do so:

1. Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e stop

2. Use the Windows Services control panel to restart the DT/
Engine service.

3. Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e start

Table 3: OSNameCleansing.xml Tag Descriptions
(1 of 2)

Tag Name Description

<Action> Specifies how the rule should be executed:

• Modify. This action updates the value of items that match the search 
pattern. This is the most commonly used action and is used for every 
categorization rule to assign categories or groups to an item.

• Remove. This action prevents matching items from being added to the 
Data Warehouse. This action is rarely used, but can be implemented to 
filter out specific items from being stored. For example, by default there 
is a filter rule that prevents zero-byte size files from being added.

<Pattern> A regular expression that specifies the string that should be matched in 
the MAC field returned by Discovery. This regular expression should 
always be wrapped in <MAC> tags.

For example, <MAC>.*Hewlett.*</MAC> would return all strings with 
one or more characters (including spaces), followed by “Hewlett” 
followed by one or more characters (including spaces). 

The rules for regular expressions are described at http://java.sun.com/
j2se/1.4.2/docs/api/java/util/regex/Pattern.html.
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Chapter 2: Administrative Tools
CaseSensitive Specifies whether this rule is case sensitive (True) or not (False). 

For example, if the rule is not case sensitive and.*Hewlett.* is the 
regular expression in your <Pattern> tag, both “Hewlett” and “hewlett” 
would match the rule. If the rule is case sensitive, only “Hewlett” would 
match.

Element List The list of parameters that should be assigned a value for all discovered 
assets that match the pattern rule. The element list generally only contains 
a single element for the OS_TYPE parameter.

Element > Name The name of the parameter that should be modified for this discovered 
asset. This value is always OS_TYPE.

Element > Value The value that should be assigned to OS_TYPE for this filter element. 
Built-in values include Windows, Unix, and Other. 

Element > Desc (Optional) A space for comments that describe the purpose of the rule.

Table 3: OSNameCleansing.xml Tag Descriptions
(2 of 2)

Tag Name Description
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Discovered Asset Categorization - 

AssetCategorization.xml

The AssetCategorization.xml files allow administrators to add or modify 
rules for categorizing discovered assets. This file is located in the 
<install_dir>\BlazentIntegrationServices\tasks\data directory 
and has the following format:

<FilterList>
<Filter>

<Action>Modify</Action>
<Pattern><OS_FAMILY>...</OS_FAMILY></Pattern> 
<CaseSensitive>...</CaseSensitive> 
<ElementList> 

<Element> 
<Name>OS_NAME</Name> 
<Value>...</Value> 
<Desc>...</Desc> 

</Element>
...

</ElementList> 
</Filter>
...

</FilterList>

Discovered asset categorization rules are defined by applying regular expressions 
to the OS field that was returned by Discovery. The OS field typically contains a 
substring that identifies the type of asset that was discovered. 
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Chapter 2: Administrative Tools
To add a new asset categorization rule, add a filter to the filter list and specify 
values for the XML tags described in Table 4. 

Note: If you make a change to AssetCategorization.xml 
you must stop and restart the Embarcadero DT/Engine for the 
changes to take effect. To do so:

1. Open a command line console and execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e stop

2. Use the Windows Services control panel to restart the DT/
Engine service.

3. Use the command line console to execute 

commandlineconsole <Embarcadero_Machine_Name> 
<port> -e start

Table 4: AssetCategorization.xml Tag Descriptions
(1 of 2)

Tag Name Description

<Action> Specifies how the rule should be executed:

• Modify. This action updates the value of items that match the search 
pattern. This is the most commonly used action and is used for every 
categorization rule to assign categories or groups to an item.

• Remove. This action prevents matching items from being added to the 
Data Warehouse. This action is rarely used, but can be implemented to 
filter out specific items from being stored. For example, by default there 
is a filter rule that prevents zero-byte size files from being added.

<Pattern> A regular expression that specifies the string that should be matched in 
the OS field returned by Discovery. This regular expression should always 
be wrapped in <OS> tags.

For example, <OS>.*Fileserver.*</OS> would return all strings 
with one or more characters (including spaces), followed by “Fileserver” 
followed by one or more characters (including spaces). 

The rules for regular expressions are described at http://java.sun.com/
j2se/1.4.2/docs/api/java/util/regex/Pattern.html.
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Oracle DBA Studio and Enterprise Manager Console
Oracle DBA Studio and Enterprise Manager 

Console 

Oracle DBA Studio (8i) and Oracle Enterprise Manager Console (9i) are 
applications that administrators can use to control the Collection and Data 
Warehouse database instances. 

! To access Oracle DBA Studio, open the Start menu of the database server and 
choose Programs > Oracle - OraHome81 > Database Administration > DBA 
Studio. 

! To access Oracle Enterprise Manager Console, open the Start menu of the 
database server and choose Programs > Oracle - OraHome91 > Database 
Administration > Enterprise Manager Console. 

For additional information, consult your Oracle documentation.

CaseSensitive Specifies whether this rule is case sensitive (True) or not (False). 

For example, if the rule is not case sensitive and.*Fileserver.* is the 
regular expression in your <Pattern> tag, both “Fileserver” and 
“fileserver” would match the rule. If the rule is case sensitive, only 
“Fileserver” would match.

Element List The list of parameters that should be assigned a value for all discovered 
assets that match the pattern rule. The element list generally only contains 
a single element for the ASSET_TYPE parameter.

Element > Name The name of the parameter that should be modified for this discovered 
asset. This value is always ASSET_TYPE.

Element > Value The value that should be assigned to ASSET_TYPE for this filter element. 
Built-in values include Server, PC, Network Equipment, Printer, 
Printer Server, and Wireless Device. 

Element > Desc (Optional) A space for comments that describe the purpose of the rule.

Table 4: AssetCategorization.xml Tag Descriptions
(2 of 2)

Tag Name Description
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Chapter 2: Administrative Tools
MicroStrategy Desktop 

MicroStrategy Desktop is an application that administrators can use to control and 
configure the Analytics Server. To access this application, open the Start menu of 
the Analytics Server and choose Programs > MicroStrategy 7 > Desktop > Desktop. 
For additional information, consult your MicroStrategy documentation.

PowerUpdate Controller 

PowerUpdate Controller is a web-based application that allows administrators to 
control and configure the PowerUpdate Server, if installed. To access this 
application, open the following URL in a web browser: 
http://<PowerUpdateServer>:8000/powerupdate/

For additional information, consult your PowerUpdate documentation.

The Blazent Database Diagnostic Tool: 

bzbs_run_diagnostics.bat

BZBS_Run_Diagnostics.bat is the Blazent database diagnostic tool that allows you 
to verify the integrity of your Collection and Data Warehouse databases. To run 
this tool:

1. Navigate to your Oracle bin directory (C:\oracle\ora<release>\bin).

2. Run bzbs_run_diagnostics.bat, and specify Exit twice to exit.

The Database Diagnostic batch file produces two files:

! bzc_diagnostics.lst includes information about the Collection 
Database.

! bzw_diagnostics.lst includes information about the Data Warehouse.

Review these files and work with Blazent Support to resolve all failed items. (See 
Appendix C,  “Technical Support.”)
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Configuring Blazent Collectors

To customize Blazent IT Intelligence Software you can configure the two Blazent 
Collectors: Blazent Agents and Blazent Discovery. 

Configuring Blazent Agents

Blazent Agents are configured through the clientconfig_<type>.xml files 
that are stored on the Collection Server in 
<install_drive>\BlazentCollectionServer\webapps\blazent\
Configuration\Client. Separate versions of clientconfig exist in this 
directory for every Blazent Agent operating system type and for Blazent Agents 
that are enabled for Discovery. This configuration allows different parameter 
values to be specified for each type of deployed Blazent Agent. 

Each Blazent Agent periodically downloads a new copy of 
clientconfig_<type>.xml in order to stay current with the most recent 
updates to the configuration. After installation and after every machine reboot, a 
Blazent Agent downloads clientconfig_<type>.xml from the Collection 
Server that is specified in the Blazent Agent’s bootstrap.xml file. 
Bootstrap.xml is installed with every Blazent Agent and only contains the 
name of a single Collection Server, or a Collection Server contained in the address 
aliased behind a load balancer. After the initial version of 
clientconfig_<type>.xml is downloaded, all subsequent downloads are 
from the Collection Server named in clientconfig_<type>.xml until the 
Blazent Agent machine is rebooted again. The frequency with which downloads 
occur is controlled by another parameter.
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Chapter 3: Configuring Blazent Collectors
Because each Blazent Agent periodically downloads 
clientconfig_<type>.xml, you can edit the configuration parameters on the 
Collection Server at any time without necessitating manual upgrade of all Blazent 
Agent configuration files. For example, suppose you deployed IT Intelligence 
Software at an organization with two Collection Servers, Server A and Server B:

! When you install a Blazent Agent at this organization, the bootstrap.xml 
file that is installed with the Blazent Agent specifies one of those servers (for 
example, Server A). After the Blazent Agent is installed and reboots, it reads 
the name of the server from bootstrap.xml and downloads the 
appropriate clientconfig file from that source. 

For example, if the Blazent Agent runs on an AIX platform, it would 
download clientconfig_aix.xml from Server A.

! If you wish to change Blazent Agent parameters for a particular operating 
system type, you can do so by editing the appropriate 
clientconfig_<type>.xml file on the Collection Server. All Blazent 
Agents of the specified type will then download this new version the next time 
they update their file. 

! If you wish to change the source of the configuration file from Server A to 
Server B:

1. Edit bootstrap.xml on the Blazent Agent to reference Server B. 

2. Edit clientconfig_<type>.xml on Server A to reference Server B 
by editing the s parameter in the LogonModule.  

Note: You must restart the Collection Server service for changes to 
clientconfig.xml to take effect.
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Configuring Blazent Agents
Clientconfig.xml Format

The clientconfig files are located in 
<install_drive>\BlazentCollectionServer\webapps\blazent\C
onfiguration\Client. One clientconfig file exists for every operating system, 
and an additional one exists for Blazent Agents that are enabled for Discovery (see 
“Configuring Blazent Discovery,” on page 64 for information):

! clientconfig_aix.xml (Blazent Agents with AIX operating systems)

! clientconfig_disc.xml (Blazent Agents that are enabled for 
Discovery)

! clientconfig_hpux.xml (Blazent Agents with HP-UX operating 
systems)

! clientconfig_linux.xml (Blazent Agents with Linux operating 
systems)

! clientconfig_mac_desktop.xml (Blazent Agents with Macintosh 
desktop operating systems)

! clientconfig_mac_server.xml (Blazent Agents with Macintosh 
server operating systems)

! clientconfig_solaris.xml (Blazent Agents with Solaris operating 
systems)

! clientconfig_win_desktop.xml (Blazent Agents with Windows 
desktop operating systems)

! clientconfig_win_server.xml (Blazent Agents with Windows server 
operating systems)

Clientconfig files have the following format:
<COMMANDLIST>

<COMMAND ENABLED="[1|0]" NAME="..." EI="[1|0]" TSI="..." 
 RASYNC="[1|0]">

<CMD>...</CMD>
<ARGS>...</ARGS>

</COMMAND>
<COMMAND ...>

...
</COMMAND>

</COMMANDLIST>
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Chapter 3: Configuring Blazent Collectors
A list of <COMMAND> statements are nested inside a <COMMANDLIST>. Each 
<COMMAND> contains the configurable attributes described in Table 5.

Clientconfig.xml Parameters

Table 6 lists the commands and arguments that can be set in a clientconfig 
file. Commands are displayed with a light grey background, while command argu-
ments are displayed with a clear background. Use an XML editor to make your 
changes.

Table 5: Command Attributes

Command Attribute Description

ENABLED
A Boolean value that determines whether this command will execute 
or not.

NAME
A unique label for the command.

EI
A Boolean value that determines whether the command should 
execute as soon as the command is parsed, without waiting for the 
timer.

TSI
The frequency (in seconds) that this command should execute. The 
default value of 86400 is equivalent to 24 hours.

RASYNC
A Boolean value that determines whether this command should run 
asynchronously, without blocking the next set of commands.

<CMD>
The command line executable name (see “Clientconfig.xml 
Parameters,” on page 58).

<ARGS>
The arguments for the specified command name (see 
“Clientconfig.xml Parameters,” on page 58). Arguments should be 
enclosed in the <ARGS></ARGS> tags for each command.  If no 
<ARGS> are specified, the Blazent Agent runs with the default 
settings.
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Configuring Blazent Agents
Table 6: Clientconfig.xml Commands and Arguments

Command Name Argument Description

<Supported by 
all commands>

l An integer between 0 and 20 that specifies the verbosity of 
log messages. The default value for this property is 3.

lfs The maximum size (in MB) of a log file before a new file is 
created. The default value for this property is 2.

resend A Boolean value that specifies whether a collector should 
resend its cached data. The default value for this property is 
false (0).

suppress A Boolean value that specifies whether to suppress error 
messages from being displayed on the Blazent Blazent 
Agent machine or not. If set to false (0), Blazent Agent users 
may see a dialog box if the Blazent Agent crashes. The 
default value for this property is true (1). 

CommandList
Refresh

If enabled, this command refreshes the list of commands 
that should be executed by the Blazent Agent.

LogonModule If enabled, this command causes the Blazent Agent to log on 
to the specified Collection Server and download the latest 
version of clientconfig.xml.

s (Required) The address of the Collection Server from which 
the Blazent Agent should download clientconfig.xml. 
For example, s=”http://collectionserver:8080/blazent/
data”

Hardware
Inventory
Collector

If enabled, this command causes the Blazent Agent to 
collect hardware inventory information.

cfn Specifies the name of the file to which the cache should be 
written.
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Chapter 3: Configuring Blazent Collectors
Software
Inventory
Collector

If enabled, this command causes the Blazent Agent to 
collect software application inventory information.

dff The name of the XML file that contains the exclusive regular 
expression filters for directories.

cdel The comma-delimited list of file extensions that should be 
included as software inventory. The default value of this 
property is “.exe”. 

tcs The number of software inventory items to aggregate before 
transmitting. The default value of this property is 100.

scs The number of files that consistute a “scan chunk.” The 
default value of this property is 100. (See also scdsi.)

isdsi The time to wait (sleep) before starting the disk scan, in 
seconds. The default value of this property is 900.

scdsi The time to wait (sleep) between “scan chunks” during a 
disk scan, in seconds. The default value of this property is 
120.

Example: tcs=”100” scs=”250” isdsi=”0” scdsi=”0” 
cdel=”.exe, .bat” dff=”SoftwareDirectoryFilterList.xml”

Package
Inventory
Collector

If enabled, this command causes the Blazent Agent to 
collect software package inventory information.

BlazentTime If enabled, this command synchronizes the Blazent Agent’s 
internal time with the current Collection Server time. 

Note: This command does not affect the Blazent Agent’s 
machine time.

Table 6: Clientconfig.xml Commands and Arguments

Command Name Argument Description
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Configuring Blazent Agents
local A Boolean value that specifies whether the BlazentTime 
function should retrieve the local copy of ServerTime and 
print the string representation to stdout. The default value 
for this property is false (0).

resynch The Collection Server from which the BlazentTime function 
should resynchronize its time. If a server is not specified, 
BlazentTime does not resynchronize its time. The default 
value for this property is null. 

Environment
Variable
Collector

If enabled, this command causes the Blazent Agent to 
collect system environment variable information.

cfn Specifies the name of the file to which the cache should be 
written.

Utilization
Collector

If enabled, this command causes the Blazent Agent to 
collect utilization information (for example, the number of 
hours that a particular software application is used).

dff The name of the XML file that contains the exclusive regular 
expression filters for directories.

cdel The comma-delimited list of file extensions that should be 
included as software inventory. The default value of this 
property is “.exe”.

emt A Boolean value that specifies whether the Blazent Agent 
should track mouse movement. The default value of this 
property is true (1).

ekt A Boolean value that specifies whether the Blazent Agent 
should track keyboard use. The default value of this property 
is true (1).

uidsi The amount of time (in seconds) that must elapse between 
keyboard and mouse events for the user to be judged 
“inactive.” The default value for this property is 300.

Table 6: Clientconfig.xml Commands and Arguments

Command Name Argument Description
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Chapter 3: Configuring Blazent Collectors
esut A Boolean value that specifies whether software utilization 
tracking should be enabled. The default value for this 
property is true (1).

emut A Boolean value that specifies whether memory utilization 
tracking should be enabled. The default value for this 
property is true (1).

eput A Boolean value that specifies whether processor utilization 
tracking should be enabled. The default value for this 
property is true (1).

dtsp The number of seconds that should elapse between data 
transmissions. The default value of this property is 3600 
(one hour).

drrt The reference date-time value that should be used to 
calculate data roll-up times. The default value of this 
property is 10-01-2001 8:00:00.

drmp The number of minutes between data roll-ups, as based on 
the drrt. The default value of this property is 30.

Example: cdel=".exe,.bat" 
dff="SoftwareDirectoryFilterList.xml" dtsp="600" 
drrt="10-01-2002 8:15:00" drmp="5"

Discovery
Collector

If enabled, this command instantiates an instance of 
Discovery (see “Configuring Blazent Discovery,” on page 64 
for information).

Note: Discovery should only be enabled on machines that 
were installed with files from the Discovery installation 
folder (as described in “Installing Blazent Discovery,” on 
page 63 of the Installation Guide).

cfg The path to the DiscoveryCollectorConfig.xml file. 
If this value is not specified, the default value of 
cache\DiscoveryCollectorConfig.xml is used.

Table 6: Clientconfig.xml Commands and Arguments

Command Name Argument Description
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Configuring Blazent Agents
Transmitter If enabled, this command causes the data that is collected by 
the Blazent Agent to be transmitted to the specified 
Collection Server.

s (Required) The address of the Collection Server with which 
the Blazent Agent should communicate.

transmit A Boolean value that specifies whether data files should be 
transmitted to the Collection Server from this Blazent 
Agent. The default value for this property is false (0).

o The file to which Collection Server responses should be 
saved.

post The file that should be sent to the Collection Server.

delay The number of seconds (between 0 and 600) that the 
Blazent Agent should wait after transmitting a file when 
transmitting multiple data files to the Collection Server.  The 
default value for this property is 10.

flimit The maximum number of files to transmit during a session. 
A value of 0 specifies no limit. The default value for this 
property is 10.

Download example: s=”http://www.yahoo.com” o=”yahoo.html”

Transmit example: s=”http://collectionserver:8080/blazent/
data” transmit=”1” delay=”10” flimit=”5”

BZUpdate If enabled, this command runs the BZUpdate.bat file, which 
sends collected data to the specified Collection Server.

Table 6: Clientconfig.xml Commands and Arguments

Command Name Argument Description
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Chapter 3: Configuring Blazent Collectors
Bootstrap.xml Format

Bootstrap.xml specifies the name of the Collection Server from which 
clientconfig.xml should be downloaded whenever a Blazent Agent machine 
is rebooted. This file is found in each of the Agent installation directories in 
<install_drive>\BlazentCollectionServer\AgentInstallers, 
and has the following format:

<SessionModule> 
<LoginServerAddress>
http://<Collection_server_name>:8080/blazent/login/
<LoginServerAddress> 
</SessionModule>

Configuring Blazent Discovery

Blazent Discovery is configured through both the clientconfig_disc.xml 
file that is stored on the Collection Server in 
<install_drive>\BlazentCollectionServer\webapps\blazent\C
onfiguration\Client, and the DiscoveryCollectorConfig.xml file 
that is stored on the Discovery Agent machine in <install_drive>\Program 
Files\Blazent\BlazentAgent\cache. 
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Configuring Blazent Discovery
Clientconfig_Disc.XML

Like Blazent Agents, Blazent Discovery periodically downloads 
clientconfig_disc.xml from a specified Collection Server to get the most 
recent updates to this file. This file contains the same commands and arguments as 
Blazent Agent clienconfig.xml files, but with the Discovery command 
enabled (see “Clientconfig.xml Format,” on page 57 and “Clientconfig.xml 
Parameters,” on page 58 for information). This file is used to control the logging 
verbosity of the Blazent Discovery instance, as well as the location of the active 
DiscoveryCollectorConfig.xml file. 

DiscoveryCollectorConfig.XML

The DiscoveryCollectorConfig.xml file is stored on the Discovery 
machine and controls the main operation of the installed Discovery application. 
Unlike clientconfig_disc.xml, this file is not periodically downloaded from 
the Collection Server and must be updated manually if you wish to make changes.

Note: If you enable the other commands in 
clientconfig_disc.xml, the Discovery installation also gathers 
the same information as a Blazent Agent for the machine on which 
Discovery is installed. Disabling these other commands prevents 
information about this machine from being included in Blazent 
Analytics reports.
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Chapter 3: Configuring Blazent Collectors
DiscoveryCollectorConfig.xml files have the following format. Each tag 
is described in Table 7:

<BLAZENTDISCOVERY ...>
<CLIENT_ID>...</CLIENT_ID>
<VERSION>

<file_update_version>...</file_update_version>
<client_version>...</client_version>

</VERSION>
<SCAN_IP_DETAILS>

<POLL_IP>
<START_IP>...</START_IP>
<END_IP>...</END_IP>

</POLL_IP>
</SCAN_IP_DETAILS>
<SCAN_IP_DETAILS>

...
</SCAN_IP_DETAILS>
...
<SNMP_POLL_FLAG>...</SNMP_POLL_FLAG>
<SOCKET_TIMEOUT>...</SOCKET_TIMEOUT>
<SOCKET_NUM_RETRIES>...</SOCKET_NUM_RETRIES>
<NMAP_PORT_LIST>...</NMAP_PORT_LIST>
<SIMULTANEOUS_NUM_IP_POLL>...</SIMULTANEOUS_NUM_IP_POLL>
<SCAN_WAIT_TIME>...</SCAN_WAIT_TIME>

</BLAZENTDISCOVERY>

Table 7: DiscoveryCollectorConfig.xml Parameters
(1 of 3)

Tag Description

CLIENT_ID The name assigned to this instance of Discovery. 
Make this ID unique if you have more than one 
instance of Discovery installed in your organization.

VERSION The current version numbers for components in this 
Discovery instance. 
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Configuring Blazent Discovery
SCAN_IP_DETAILS Information about the IP address ranges that should 
be scanned by this instance of Discovery. You can 
include multiple SCAN_IP_DETAILS tags in 
DiscoveryCollectorConfig.xml.

Important Note: Two instances of Discovery should 
not poll the same IP addresse range, or poll 
overlapping IP address ranges. If this occurs, 
synchronization issues can occur in your Collection 
Database.

SCAN_IP_DETAILS > POLL_IP <START_IP>: The beginning of the IP address range 
that should be scanned by this Discovery instance.

<END_IP>: the end of the IP address range that 
should be scanned by this Discovery instance.

Important Note: Two instances of Discovery should 
not poll the same IP addresse range, or poll 
overlapping IP address ranges. If this occurs, 
synchronization issues can occur in your Collection 
Database.

SNMP_POLL_FLAG If true, specifies that Discovery will use SNMP to 
gather MAC addresses for non-Windows assets. If 
false, this information will not be gathered.

SOCKET_TIMEOUT The number of seconds that should elapse before the 
socket that is used for communication with the 
Collection Server can time out.

SOCKET_NUM_RETRIES The number of retry attempts that should occur after 
a socket times out.

NMAP_PORT_LIST A list of standard port numbers that should be used 
for NMAP communication between the Discovery 
instance and the IP addresses it is polling. The default 
values for this list include: 
7,21,23,25,53,80,110,135,139,445,514,5
15,1977,1066

Table 7: DiscoveryCollectorConfig.xml Parameters
(2 of 3)

Tag Description
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Chapter 3: Configuring Blazent Collectors
SIMULTANEOUS_NUM_IP_POLL The number of IP addresses that can be polled 
simultaneously by this instance of Discovery. 
Increasing this value increases the amount of system 
resources and network bandwidth that will be used by 
Discovery.

SCAN_WAIT_TIME The number of seconds that this instance of 
Discovery must wait between scans.

Table 7: DiscoveryCollectorConfig.xml Parameters
(3 of 3)

Tag Description
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Performance Tuning

This chapter includes information on the parameters that should be adjusted to 
improve the performance of your Blazent IT Intelligence Software installation. In 
several cases, these requirements change depending on the number of Blazent 
Agents that are deployed. For the purposes of this chapter, deployment sizes are 
grouped into the following categories:

! Small (less than 2,000 Blazent Collectors)

! Medium (2,000 - 10,000 Blazent Collectors)

! Large (10,000 - 30,000 Blazent Collectors)

! Extra-Large (30,000 - 60,000 Blazent Collectors)

! Custom (more than 60,000 Blazent Collectors)

The remainder of the chapter discusses performance tuning parameters, organized 
by Blazent component.

Blazent Agents

A Blazent Agent can be configured to collect more or less data by altering its 
clientconfig.xml file. See “Configuring Blazent Agents,” on page 55 for 
details.
Blazent Confidential 69



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Chapter 4: Performance Tuning
Database Server Performance Tuning

To tune an Intelligence Platform Database Server for better performance, you 
should configure the following types of parameters:

! Machine-level parameters

! arraySize guidelines

! Windows

! Solaris

! Database instance parameters

! Tablespace sizing guidelines

! Combined instance (both Collection database and Data Warehouse)

! Collection database only

! Data Warehouse only

! Physical table parameters

Machine-Level Parameters

The following sections describe the machine settings that should be configured for 
Oracle servers on Windows and Solaris machines.

Setting an Array Size

Based on the amount of memory that is allocated to your database server, you 
should tune the Oracle arraySize parameter so that Data Integration Services 
displays better performance. Although the default value is 5, you can set this 
parameter up to 10,000. Contact Blazent Customer Support for help with 
determining the best value for your particular installation. 
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Database Server Performance Tuning
To edit this parameter:

1. Navigate to the Oracle bin directory and open bzwLib_pkg.sql.

2. Find arraySize NUMBER := 5;, and set it to the appropriate value.

Windows

Use the following guidelines to configure the Windows machine on which your 
Oracle 8i or 9i server runs:

! Oracle 8i and 9i require special configuration settings to run on Windows 
2000 machines. Please refer to the Oracle Platform Deployment Guide for 
information.

! The Windows machine on which Oracle 9i release 2 (9.2) is installed must 
have more than 4 GB of memory.

! Windows must have Physical Address Extensions (PAE) enabled. To do so, 
see Microsoft Knowledge Base article Q268363 for instructions on how to 
modify boot.ini to enable PAE.

! Blazent recommends that you enable 4GT support by adding the /3GB 
parameter in boot.ini. See Microsoft Knowledge Base article Q171793 for 
information on enabling 4GT support.

! The user account under which Oracle 9i release 2 (9.2) runs (typically 
LocalSystem) must have the Lock memory pages Windows 2000 
privilege.

! The initialization parameter file for an Oracle 9i database instance that uses 
VLM support must include USE_INDIRECT_DATA_BUFFERS=TRUE. If this 
parameter is not set, Oracle behaves in the same way as previous releases.

! The DB_BLOCK_BUFFERS and DB_BLOCK_SIZE initialization parameters 
must be set to the same values that were chosen for your Oracle 9i database.
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Chapter 4: Performance Tuning
Solaris

Blazent IT Intelligence Software can run on Solaris versions 8 and 9. See the 
Oracle Installation Guide for information on the latest patches that are necessary 
to run Oracle 8.1.7.4 and Oracle 9.2.0.5.

Table 8 shows configuration parameters that are set in the /etc/system file. Use 
the values that are appropriate for the number of Blazent Collectors that are 
deployed in your installation.

Table 8: Solaris Database Server Configuration Parameters 
(1 of 2)

OS Parameter Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60,000)

Custom

(> 60,000)

ts_sleep_promote 1 1 1 1 1

autoup 60 100 300 300 300

rlim_fd_max 4096 4096 4096 4096 4096

rlim_fd_cur 1024 1024 1024 1024 1024

sd_max_throttle 24 24 24 24 24

sd_io_time 0x3c 0x3c 0x3c 0x3c 0x3c

sd_retry_count 10 10 10 10 10

tune_t_gpgslo 250 250 250 250 250

tune_t_minarmem 100 100 100 100 100

tune_t_minasmem 250 250 250 250 250

msgsys:msginfo_msgmap 200 200 200 200 200

msgsys:msginfo_msgmni 100 100 100 100 100

msgsys:msginfo_msgtql 80 80 80 80 80

msgsys:msginfo_msgseg 2048 2048 2048 2048 2048
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Database Server Performance Tuning
Database Instance Parameters

You can deploy your Collection Database and Data Warehouse in multiple 
configurations. For small, medium and large installations, you can combine both 
sets of schema into a single database instance. For extra-large and custom 
installations, separate the Collection database and Data Warehouse into different 
instances on the same machine. The following sections outline tablespace sizing 
requirements for each instance type, and parameters for both combined and 
separate database instance configurations.

shmsys:shminfo_shmmax 0xFFFFFF
FFF

0xFFFFFF
FFF

0xFFFFFF
FFF

0xFFFFFF
FFF

0xFFFFFFF
FF

shmsys:shminfo_shmmin 1 1 1 1 1

shmsys:shminfo_shmmni 1000 1000 1000 1000 1000

shmsys:shminfo_shmseg 200 200 200 200 200

semsys:seminfo_semmns 3400 3400 3400 3400 3400

semsys:seminfo_semmni 2000 2000 2000 2000 2000

semsys:seminfo_semmsl 500 500 500 500 500

semsys:seminfo_semmap 500 500 500 500 500

semsys:seminfo_semmnu 600 600 600 600 600

semsys:seminfo_semume 600 600 600 600 600

Table 8: Solaris Database Server Configuration Parameters 
(2 of 2)

OS Parameter Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60,000)

Custom

(> 60,000)
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Chapter 4: Performance Tuning
Instance-Level Tablespace Sizing Guidelines

Table 9 includes tablespace sizing requirements that will allow your Blazent IT 
Intelligence Software application to function correctly.  

Note: The System tablespace size does not include the space 
allocated to other default Oracle tablespaces, such as Users, Tools, 
Example, and so on.

Note: The number of disks that are allocated to the Rollback 
tablespace should be the same as the number allocated to data 
segments because there are as many IO operations occuring in the 
Rollback tablespace as there are write operations on the data 
segments. The capacity of the disks that are used for Rollback are 
much larger than the size of the rollback segments themselves.

Table 9: Database Instance Tablespace Sizing Requirements

Tablespace Name Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60, 000)

Custom

(> 60,000)

System 300 MB 350 MB 350 MB 500 MB 500 MB

Rollback or Undo Tablespace 2 GB 4 GB 10 GB 20 GB 30 GB

Temp Tablespace 4 GB 8 GB 16 GB 24 GB 36 GB
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Database Server Performance Tuning
Combined Collection Database and Data Warehouse Instance 

Parameters

Table 10 shows the parameters that should be used for a database instance that 
contains both the Collection Database and Data Warehouse schemas. This 
configuration can be used for installations that deploy up to 30,000 Blazent 
Collectors.

Table 10: Combined Collection Database and Data Warehouse Instance Parameters

(1 of 4)

Oracle 

Parameter 

Name

V. 8.1.7.4 

Small 

( < 2,000)

V. 8.1.7.4 

Medium 

(2,000 - 

10, 000)

V. 8.1.7.4 

Large 

(10,000 - 

30, 000)

V. 9.2.0.4 

Small 

( < 2,000)

V. 9.2.0.4 

Medium 

(2,000 - 

10, 000)

V. 9.2.0.4 

Large 

(10,000 - 

30, 000)

bitmap_merge_
area_size

1048576 1048576 1048576

buffer_pool_
keep

500 MB 1 GB 2 GB

buffer_pool_
recycle

circuits

compatible 8.1.7 8.1.7 8.1.7 9.2.0 9.2.0 9.2.0

create_bitmap_
area_size

8388608 8388608 8388608

cursor_sharing EXACT EXACT EXACT EXACT EXACT EXACT

cursor_space_
for_time

FALSE FALSE FALSE FALSE FALSE FALSE

db_block_
buffers

2 GB 6 GB 12 GB

db_block_
checksum

TRUE TRUE TRUE TRUE TRUE TRUE

db_block_size 8192 8192 8192 8192 8192 8192
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Chapter 4: Performance Tuning
db_cache_
advice

ON ON ON

db_cache_size 2 GB 6 GB 12 GB

db_file_
multiblock_
read_count

16 16 16 16 16 16

db_files 200 200 200 200 200 200

db_keep_cache_
size

1 GB 2 GB 4 GB

db_recycle_
cache_size

db_writer_
processes

2 4

dbwr_io_slaves

disk_asynch_io TRUE TRUE TRUE TRUE TRUE TRUE

dml_locks 768 768 768 768 768 768

enqueue_
resources

968 968 968 968 968 968

hash_area_size 10 MB 10 MB 15 MB

hash_join_
enabled

TRUE TRUE TRUE TRUE TRUE TRUE

java_pool_size 20 MB 20 MB 20 MB 20 MB 20 MB 20 MB

Table 10: Combined Collection Database and Data Warehouse Instance Parameters

(2 of 4)

Oracle 

Parameter 

Name

V. 8.1.7.4 

Small 

( < 2,000)

V. 8.1.7.4 

Medium 

(2,000 - 

10, 000)

V. 8.1.7.4 

Large 

(10,000 - 

30, 000)

V. 9.2.0.4 

Small 

( < 2,000)

V. 9.2.0.4 

Medium 

(2,000 - 

10, 000)

V. 9.2.0.4 

Large 

(10,000 - 

30, 000)
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Database Server Performance Tuning
large_pool_
size

400 MB 800 MB 1200 MB

log_
parallelism

1 1 1 1 1 1

log_buffer 200 MB 200 MB 400 MB 200 MB 200 MB 400 MB

log_
checkpoint_
interval

9600 9600 14400 9600 9600 14400

log_
checkpoint_
timeout

1800 1800 1800 1800 1800 1800

nls_language American American American American American American

open_cursors 1000 1000 1000 1000 1000 1000

parallel_
execution_
message_size

32 kB 32 kB 32 kB 32 kB 32 kB 32 kB

parallel_
automatic_
tuning

FALSE FALSE FALSE TRUE TRUE TRUE

parallel_max_
servers

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

parallel_
threads_per_
cpu

2 2 2 2 2 2

Table 10: Combined Collection Database and Data Warehouse Instance Parameters

(3 of 4)

Oracle 

Parameter 

Name

V. 8.1.7.4 

Small 

( < 2,000)

V. 8.1.7.4 

Medium 

(2,000 - 

10, 000)

V. 8.1.7.4 

Large 

(10,000 - 

30, 000)

V. 9.2.0.4 

Small 

( < 2,000)

V. 9.2.0.4 

Medium 

(2,000 - 

10, 000)

V. 9.2.0.4 

Large 

(10,000 - 

30, 000)
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Chapter 4: Performance Tuning
pga_aggregate_
target

1.4 GB 1.4 GB 2.0 GB 1.4 GB 1.4 GB 2.0 GB

processes 300 400 600 300 400 600

sort_area_
retained_size

4 MB 10 MB 40 MB 4 MB 10 MB 40 MB

shared_pool_
reserved_size

50 MB 100 MB 200 MB 50 MB 100 MB 200 MB

shared_pool_
size

200 MB 400 MB 800 MB 200 MB 400 MB 800 MB

sort_area_size 25 MB 50 MB 200 MB AUTO AUTO AUTO

undo_
management

TRUE TRUE TRUE

workarea_size_
policy

AUTO AUTO AUTO

Table 10: Combined Collection Database and Data Warehouse Instance Parameters

(4 of 4)

Oracle 

Parameter 

Name

V. 8.1.7.4 

Small 

( < 2,000)

V. 8.1.7.4 

Medium 

(2,000 - 

10, 000)

V. 8.1.7.4 

Large 

(10,000 - 

30, 000)

V. 9.2.0.4 

Small 

( < 2,000)

V. 9.2.0.4 

Medium 

(2,000 - 

10, 000)

V. 9.2.0.4 

Large 

(10,000 - 

30, 000)
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Database Server Performance Tuning
Collection Database Instance Parameters

Table 11 shows the database instance parameters that should be used for a stand-
alone Collection database.

Table 11: Stand-Alone Collection Database Instance Parameters
(1 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60, 000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60, 000)

V. 9.2.0.4

Custom 

(> 60,000)

bitmap_merge_area_size 1048576 1048576

buffer_pool_keep 1 GB 2 GB

buffer_pool_recycle

circuits

compatible 8.1.7 8.1.7 9.2.0.0 9.2.0.0

create_bitmap_area_size 8388608 8388608

cursor_sharing EXACT EXACT EXACT EXACT

cursor_space_for_time FALSE FALSE FALSE FALSE

db_block_buffers 3 GB 6 GB

db_block_checksum TRUE TRUE TRUE TRUE

db_block_size 8192 8192 8192 8192

db_cache_advice ON ON

db_cache_size 3 GB 6 GB

db_file_multiblock_
read_count

16 16 16 16

db_files 200 200 200 200

db_keep_cache_size 1 GB 2 GB
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Chapter 4: Performance Tuning
db_recycle_cache_size

db_writer_processes 4 6 4 6

dbwr_io_slaves

disk_asynch_io TRUE TRUE TRUE TRUE

dml_locks 768 768 768 768

enqueue_resources 968 968 968 968

hash_area_size 10 MB 15 MB

hash_join_enabled TRUE TRUE TRUE TRUE

java_pool_size 20 MB 20 MB 20 MB 20 MB

large_pool_size 1200 MB 1200 MB

log_parallelism 1 1 1 1

log_buffer 200 MB 400 MB 200 MB 400 MB

log_checkpoint_interval 9600 14400 9600 14400

log_checkpoint_timeout 1800 1800 1800 1800

nls_language American American American American

open_cursors 1000 1000 1000 1000

parallel_execution_
message_size

32 kB 32 kB 32 kB 32 kB

parallel_automatic_
tuning

FALSE FALSE FALSE FALSE

Table 11: Stand-Alone Collection Database Instance Parameters
(2 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60, 000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60, 000)

V. 9.2.0.4

Custom 

(> 60,000)
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Database Server Performance Tuning
parallel_max_servers Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

parallel_threads_per_
cpu

2 2 2 2

pga_aggregate_target 1.4 GB 2.0 GB 1.4 GB 2.0 GB

processes 400 600 400 600

sort_area_retained_size 20 MB 40 MB 20 MB 40 MB

shared_pool_reserved_
size

200 MB 200 MB 200 MB 200 MB

shared_pool_size 600 MB 800 MB 600 MB 800 MB

sort_area_size 200 MB 200 MB AUTO AUTO

undo_management - - TRUE TRUE

workarea_size_policy - - AUTO AUTO

Table 11: Stand-Alone Collection Database Instance Parameters
(3 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60, 000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60, 000)

V. 9.2.0.4

Custom 

(> 60,000)
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Chapter 4: Performance Tuning
Data Warehouse Instance Parameters

Table 12 shows the database instance parameters that should be used for a stand-
alone Data Warehouse.

Table 12: Stand-Alone Data Warehouse Instance Parameters
(1 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60,000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60,000)

V. 9.2.0.4

Custom 

(> 60,000)

bitmap_merge_area_size 1048576 1048576

buffer_pool_keep 4 GB 6 GB

buffer_pool_recycle

circuits

compatible 8.1.7 8.1.7 9.2.0.0 9.2.0.0

create_bitmap_area_size 8388608 8388608

cursor_sharing EXACT EXACT EXACT EXACT

cursor_space_for_time FALSE FALSE FALSE FALSE

db_block_buffers 8 GB 12 GB

db_block_checksum TRUE TRUE TRUE TRUE

db_block_size 16 kB 16 kB 16 kB 16 kB

db_cache_advice ON ON

db_cache_size 8 GB 12 GB

db_file_multiblock_
read_count

16 16 16 16

db_files

db_keep_cache_size 2 GB 4 GB
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Database Server Performance Tuning
db_recycle_cache_size

db_writer_processes 4 6 4 6

dbwr_io_slaves

disk_asynch_io TRUE TRUE TRUE TRUE

dml_locks 768 768 768 768

enqueue_resources 968 968 968 968

hash_area_size 10 MB 15 MB

hash_join_enabled TRUE TRUE TRUE TRUE

java_pool_size 20 MB 20 MB 20 MB 20 MB

large_pool_size 1200 MB 1200 MB

log_parallelism 1 1 1 1

log_buffer 200 MB 400 MB 200 MB 400 MB

log_checkpoint_interval 9600 14400 9600 14400

log_checkpoint_timeout 1800 1800 1800 1800

nls_language American American American American

open_cursors 1000 1000 1000 1000

parallel_execution_
message_size

32 kB 32 kB 32 kB 32 kB

parallel_automatic_
tuning

FALSE FALSE TRUE TRUE

Table 12: Stand-Alone Data Warehouse Instance Parameters
(2 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60,000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60,000)

V. 9.2.0.4

Custom 

(> 60,000)
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Chapter 4: Performance Tuning
parallel_max_servers Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

Twice the 
number of 
CPUs

parallel_threads_per_
cpu

2 2 2 2

pga_aggregate_target 1.4 GB 2.0 GB 1.4 GB 2.0 GB

processes 150 200 150 200

sort_area_retained_size 20 MB 40 MB 20 MB 40 MB

shared_pool_reserved_
size

200 MB 200 MB 200 MB 200 MB

shared_pool_size 800 MB 800 MB 800 MB 800 MB

sort_area_size 200 MB 400 MB AUTO AUTO

undo_management - - TRUE TRUE

workarea_size_policy - - AUTO AUTO

Table 12: Stand-Alone Data Warehouse Instance Parameters
(3 of 3)

Oracle Parameter Name V. 8.1.7.4 X-

Large 

(30,000 - 

60,000)

V. 8.1.7.4

Custom 

(> 60,000)

V. 9.2.0.4 X-

Large 

(30,000 - 

60,000)

V. 9.2.0.4

Custom 

(> 60,000)
Blazent Confidential 84

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Collection Server Performance Tuning
Physical Table Parameters

Table 13 lists physical table parameters that should be changed to support parallel 
query and DML operations. For more information, see the Oracle Administration 
Guide, or the Oracle SQL Reference Manual.

Collection Server Performance Tuning

One Collection Server can support up to 10,000 Blazent Agents. Therefore, a large, 
extra-large, or custom installation requires deployment of multiple Collection 
Servers. 

To tune a Collection Server for better performance, you should configure 
parameters for the Windows machine on which it runs, as well as the actual 
Collection Server application.

Table 13: Physical Table Parameters

Parameter Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60,000)

Custom

(> 60,000)

ini_trans 2 2 2 4 8

pct_free 5 5 5 5 5

pct_used 90 90 90 90 90

freelists 32 32 32 32 32

cache Yes Yes Yes Yes Yes
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Chapter 4: Performance Tuning
Machine Parameters

Table 14 describes the parameters that should be configured on a Collection Server 
Windows 2000 machine.

Table 14: Collection Server Machine Parameters 

Parameter Location Description

Maximize Data Throughput 
for Network Applications

1. Right-click My Network 

Places and choose 
Properties. 

2. Right-click Local Area 

Connection and choose 
Properties.

3. Select File and Printer 
Sharing for Microsoft 
Networks. and click 
Properties.

4. Select Maximize data 
throughput for network 
applications.

This setting significantly reduces the 
number of page faults that occur 
under high-load conditions. This 
setting also improves cache 
management.

Disable Performance 
Optimization for 
Applications

1. Right-click My Computer 

and choose Properties. 
2. In the Advanced tab, click 

Performance Options.
3. In the Application Response 

area, choose Background 

services.

If the Collection Server is a 
dedicated machine, disable this 
parameter so that Windows 
maximizes the number of CPU 
cycles that are available to the 
Collection Server.

Modify the Number of 
TCP/IP User Ports

Use regedit to set 
HKEY_LOCAL_MACHINE/
System/
CurrentControlSet/
Services/Tcpip/
Parameters/
MaxUserPort to 0xFFFE.

This setting increases the number of 
ports so that one is available 
whenever a request arrives.
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Collection Server Performance Tuning
Application Parameters

Table 15 describes the settings that should be configured during Collection Server 
installation. You can also modify these settings after installation by editing 
<install_dir>\BlazentCollectionServer\conf\server.xml.

Table 15: Collection Server Application Settings 
(1 of 3)

Setting Post-Installation 

Setting Location

Value

Minimum JRE Heap Size In <install_dir>\
BlazentCollection
Server\conf\jk\
wrapper.properties, 
edit the following line:

wrapper.cmd_line=
$(wrapper.javabin) 
-Xms32m -Xmx64m ...

Replace the 32 with the 
minimum JRE heap size, in 
Megabytes. For example, if 
you have 2GB of total 
memory, enter -Xms256m

Save the properties file and 
restart the Blazent Server 
service.

256 MB for 1 GB total memory,
512 MB for 2 GB total memory,
2 GB for 4 GB total memory, 
and so on.
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Chapter 4: Performance Tuning
Maximum JRE Heap Size In <install_dir>\
BlazentCollection
Server\conf\jk\
wrapper.properties, 
edit the following line:

wrapper.cmd_line=
$(wrapper.javabin) 
-Xms32m -Xmx64m ...

Replace the 64 with the 
maximum JRE heap size, in 
Megabytes. For example, if 
you have 2GB of total 
memory, enter -Xmx512m

Save the properties file and 
restart the Blazent Server 
service.

256 MB for 1 GB total memory,
512 MB for 2 GB total memory,
1024 MB for 4 GB total memory, 
and so on.

Swap space 2 GB

Minimum processors minProcessors setting in 
<install_dir>\
BlazentCollection
Server\conf\
server.xml

Maximum processors maxProcessors setting in 
<install_dir>\
BlazentCollection
Server\conf\
server.xml

Accept count acceptCount setting in 
<install_dir>\
BlazentCollection
Server\conf\
server.xml

Table 15: Collection Server Application Settings 
(2 of 3)

Setting Post-Installation 

Setting Location

Value
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Data Integration Services Performance Tuning
Data Integration Services Performance 

Tuning

The amount of memory (JVM heap size) that is allocated to the Embarcadero 
DT/Engine changes with the size of the installation. The minimum and maxi-
mum heap sizes (which should be identical) should be equivalent to half of the 
total physical memory that is available to Embarcadero. 

! During Embarcadero installation, you can set the minimum and maximum 
heap size in the JVM Settings screen. Set both Min. heap size (MB) and Max. 
heap size to half of the value for Total physical memory (MB). 

! After installation, you can configure these settings by editing the 
dtengine.ja file under DT_HOME/bin. For example, if you want to 
specify a minimum and maximum heap size of 512 MB, edit dtengine.ja 
as follows:
%IF_EXISTS%("INIT_JAVA_HEAP", "@INIT_JAVA_HEAP@512m") 
%IF_EXISTS%("MAX_JAVA_HEAP", "@MAX_JAVA_HEAP@512m")

Timeout connectionTimeout setting 
in <install_dir>\
BlazentCollection
Server\conf\
server.xml

Database connection pool 
size

In <install_dir>\
BlazentCollection
Server\webapps\
blazent\
Configuration\
dbconfig.xml, edit the 
MAXPOOL parameter.

200 per processor

Table 15: Collection Server Application Settings 
(3 of 3)

Setting Post-Installation 

Setting Location

Value
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Chapter 4: Performance Tuning
Analytics Server Performance Tuning

To tune an Analytics Server for better performance, you should:

! run the AnalyzeWarehouseDB task in Embarcadero to optimize the Data 
Warehouse for reports.

! configure parameters for the Windows machine on which it runs.

! configure parameters for the MicroStrategy application.

! configure parameters for the web server. 

The AnalyzeWarehouseDB Task

To fully optimize the Data Warehouse for reporting, Blazent Data Integration 
Services includes a task called AnalyzeWarehouseDB. Normally scheduled to 
run once a week on a non-work day, this task should be initially executed after 
running several reports in Blazent Analytics. Running several reports before 
running AnalyzeWarehouseDB provides the task with enough data to tune the 
Data Warehouse more effectively.

Machine Parameters

Table 16 describes the parameters that should be configured on an Analytics 
Server Windows 2000 machine. See the Tuning Guidelines for MicroStrategy 7.x 
PDF document for additional details.
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Analytics Server Performance Tuning
Table 16: Analytics Server Machine Parameters 
(1 of 3)

Parameter Location Description

Maximize Data Throughput 
for Network Applications

1. Right-click My Network 

Places and choose 
Properties. 

2. Right-click Local Area 

Connection and choose 
Properties.

3. Select File and Printer 
Sharing for Microsoft 
Networks. and click 
Properties.

4. Select Maximize data 
throughput for network 
applications.

This setting significantly reduces the 
number of page faults that occur 
under high-load conditions. This 
setting also improves cache 
management.

Disable Performance 
Optimization for 
Applications

1. Right-click My Computer 

and choose Properties. 
2. In the Advanced tab, click 

Performance Options.
3. In the Application Response 

area, choose Background 

services.

If the Analytics Server is a dedicated 
machine, disable this parameter so 
that Windows maximizes the 
number of CPU cycles that are 
available to MicroStrategy.

Modify the Number of 
TCP/IP User Ports

Use regedit to set 
HKEY_LOCAL_MACHINE/
System/
CurrentControlSet/
Services/Tcpip/
Parameters/
MaxUserPort to 0xFFFE.

This setting increases the number of 
ports so that one is available 
whenever a request arrives.

Modify the TCP/IP Window 
Size

Use regedit to set 
HKEY_LOCAL_MACHINE/
System/
CurrentControlSet/
Services/Tcpip/
Parameters/
TCPWindowSize to 
0x4470.

Increasing this setting prevents the 
MicroStrategy service from 
stopping because of a full window.
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Chapter 4: Performance Tuning
Modify HeapMaxSize 1. Use regedit to set 
HKEY_LOCAL_MACHINE/
Software/
MicroStrategy/
JNI Bridge/
Configuration/
JVM Options/
HeapMaxSize to 256 
MB or larger.

2. Use the Windows Services 
control panel to restart IIS, 
the World Wide 
Publishing Service, and 
MicroStrategy Intelligence 
Server 7.

This setting prevents 
java.lang.OutOfMemoryErrors 
from occurring when a user is 
running a report that returns a large 
amount of data. 

Tune ProcessorThreadMax 1. Open a command prompt 
and navigate to the 
inetpub\
adminscripts directory.

2. Type: 
adsutil.vbs set 
w3svc/
aspprocessorthread
max 10

This setting defines the number of 
threads that IIS allocates for ASP 
processing for each CPU.

To tune this value, begin with 10 (20 
for large, extra-large, and custom 
installations), and then adjust it 
according to the level of CPU 
utilization at peak hours. You should 
aim to observe 50-60% CPU 
utilization during off-peak hours, 
and close to 100% utilization during 
peak times.

Table 16: Analytics Server Machine Parameters 
(2 of 3)

Parameter Location Description
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Analytics Server Performance Tuning
Tune RequestQueueMax 1. Open a command prompt 
and navigate to the 
inetpub\
adminscripts directory.

2. Type: 
adsutil.vbs set 
w3svc/
asprequestqueuemax 
10

This setting controls the queue that 
allows the web server to keep 
requests that could not be 
immediately processed by the ASP 
threads. 

A request queue that is too small 
results in “Server Too Busy” errors, 
while a request queue that is too 
large results in a site that appears to 
hang. The ideal setting ensures good 
response time, while minimizing the 
“Server Too Busy” condition. 
Requests should also be processed 
within the response time limit of 20 
seconds.

To tune this setting, start with a 
value equal to ten times the value for 
ProcessorThreadMax. (Use twenty 
times the number of total threads 
for large, extra-large, and custom 
installations.) Monitor the web 
server’s queue size and response 
times and adjust the setting 
accordingly. 

Modify the Number of Script 
Engine Caches

1. Open a command prompt 
and navigate to 
SystemRoot\System32\in
etsrv\adminsamples.

2. Type:
adsutil.vbs SET 
W3SVC/
AspScriptEngine
CacheMax N
where N is equal to 
ProcessorThreadMax x 
the number of CPUs in the 
machine.

This setting controls the number of 
ASP threads that can cache a script 
engine. ASP pages are processed 
more efficiently if a script engine 
cache is in place. 

To tune this setting, start with the 
default value.

Table 16: Analytics Server Machine Parameters 
(3 of 3)

Parameter Location Description
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Chapter 4: Performance Tuning
MicroStrategy Parameters

Table 17 describes the parameters that can be tuned within the MicroStrategy 
application. 

Table 17: MicroStrategy Parameters
(1 of 2)

Parameter Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60,000)

Custom

(> 60,000)

Maximum Number of Caches

The number of caches that 
the MicroStrategy Intelligence 
Server will store.

10000 10000 10000 10000 10000

Number of Database 
Connections

The number of database 
connections. Blazent 
recommends that you keep 
this value between 40 and 60. 
Each connection that you add 
uses more server resources.

10 10 20 40 60

Number of Connection 
Threads

The number of network 
threads that can take requests 
from a web client. Each 
network thread can manage 
64 connections.

10 10 10 10 10

Max Number of Elements to 
Display

2000 2000 2000 2000 2000

Max Report Execution Time 600 600 1200 1200 1200

Max Number of Report 
Result Rows

32000 32000 32000 32000 32000
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Analytics Server Performance Tuning
Web Server Parameters

Table 18 describes the parameters that should be configured on the Blazent 
Analytics web server.

Max Number of Element 
Rows

32000 32000 32000 32000 32000

Max Number of Intermediate 
Rows

32000 32000 32000 128000 320000

Max Jobs Per User 100 100 100 100 100

Max Jobs Per User Session 100 100 100 100 100

Max Jobs Per Project 1000 1000 1000 1000 1000

Table 18: Web Server Machine Parameters 
(1 of 2)

Parameter Location Description

Tune Web Server 
Performance

1. From the Start menu, 
choose Programs > 
Administrative Tools> 
Internet Services Manager.

2. Expand the name of the 
machine in the left 
navigation bar.

3. Right-click Default Web Site 
and choose Properties.

4. In the Performance tab, set 
the Performance Tuning bar 
to More than 100,000.

This setting optimizes the web 
server for a large number of hits.

Table 17: MicroStrategy Parameters
(2 of 2)

Parameter Small 

(< 2,000)

Medium 

(2,000 - 

10,000)

Large 

(10,000 - 

30,000)

X-Large 

(30,000 - 

60,000)

Custom

(> 60,000)
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Chapter 4: Performance Tuning
Disable IIS Logging 1. From the Start menu, 
choose Programs > 
Administrative Tools> 
Internet Services Manager.

2. Expand the name of the 
machine in the left 
navigation bar.

3. Right-click Default Web Site 
and choose Properties.

4. In the Web Site tab, 
unselect the Enable Logging 
option.

This setting disables web server 
logging. By disabling logging, more 
resources are available to support 
Blazent Analytics users.

If you need to keep logging enabled, 
make sure that the path to the log 
file maps to a partition with a 
controller that allows write-back 
caching.

Minimize the Session Timout 
value

1. From the Start menu, 
choose Programs > 
Administrative Tools> 
Internet Services Manager.

2. Expand the name of the 
machine in the left 
navigation bar.

3. Right-click Default SMTP 

Virtual Server and choose 
Properties.

4. In the General tab, click 
Connection.

5. Modify the two Time-out 

(minutes) text boxes to an 
appropriate value.

This setting specifies how quickly a 
session will time out during user 
inactivity. The sooner an idle session 
times out, the sooner more system 
resources are available for active 
users. 

Blazent recommends that you set 
this value between 5-10 minutes.

Increase the Request 
Timeout value

In the Blazent Analytics 
Administrator page 
(accessible with a link from 
the Analytics Home page, or 
by using http://
<AnalyticsServer>/
blazent/admin), change 
Request timeout to 300.

This setting specifies how long the 
web server should wait for a prompt 
to load before issuing a time out 
error. Blazent recommends that you 
set this value to 300 seconds (5 
minutes).

Table 18: Web Server Machine Parameters 
(2 of 2)

Parameter Location Description
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Maintenance

This chapter describes common procedures for maintaining your IT Intelligence 
Software installation.

Running the Analyze Tasks

To fully optimize the Data Warehouse and Collection Database, Blazent provides 
two tasks in Data Integration Services that analyze normal use patterns to make the 
databases more efficient:

! AnalyzeCollectionDB. This task optimizes the performance of the Collection 
Database. Schedule this task chain to run once a week on a non-work day 
(such as Saturday).

! AnalyzeWarehouseDB. This task optimizes the performance of the Data 
Warehouse. Schedule this task chain to run once a week on a non-work day 
(such as Saturday). To make the best use of this task, run it for the first time 
only after you have run several reports in Blazent Analytics.
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Chapter 5: Maintenance
Running the Purge Utilization Table Tasks

Blazent also provides tasks in Data Integration Services that delete outdated 
utilization information from the Collection Database. Regularly removing 
outdated data ensures consistent database performance:

! purgeUtilDataHourly. This task deletes outdated hourly utilization data from the 
Collection Database. Schedule this task to run once a day after 
scheduled_tasks completes.

! purgeUtilDataMonthly. This task deletes outdated monthly utilization data from 
the Collection Database. Schedule this task to run on the first weekend of 
every month after scheduled_tasks completes.

Removing Outdated MicroStrategy Temp 

Tables

When generating reports, MicroStrategy uses temporary tables in the Data 
Warehouse to improve performance. These tables are prefixed with the letters ZZ, 
and are deleted at the end of each report query. If a report quits unexpectedly, the 
temporary tables are not deleted and must be removed manually to release the disk 
space. 

To reclaim disk storage, Blazent recommends that database administrators 
periodically cleanse the Data Warehouse of all tables that begin with the letters ZZ 
and that are more than one week old. 
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Backing Up Blazent Databases
Backing Up Blazent Databases

Blazent recommends that you schedule regular backups of all databases according 
to the backup procedure that is currently in use at your organization. Since Blazent 
databases run in NOARCHIVELOG mode to improve performance, you must rely 
on the backups that you create in case of a fatal server crash.

You can back up data in your Collection Database and Data Warehouse by 
periodically exporting the contents of the databases to other files. Use the import 
and export procedures below for these tasks.

Exporting Data from the Collection and Data 

Warehouse Databases

Blazent provides standard scripts for backing up the Collection Database and Data 
Warehouse. These scripts use the Oracle export utility:

! To export the Collection Database, run bzbs_export_blazent_db.bat 
from the Oracle bin\blazent directory (for example, 
C:\oracle\ora<release>\bin\blazent). The data is saved to 
blazent_db.dmp in the same directory.

! To export the Data Warehouse, run bzbs_export_blazent_dw_db.bat 
from the Oracle bin\blazent directory (for example, 
C:\oracle\ora<release>\bin\blazent). The data is saved to 
blazent_dw_db.dmp in the same directory.
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Chapter 5: Maintenance
Importing Data into a Collection or Data 

Warehouse Database

To import standard category data and other tables from an export (.dmp) file, use 
the following procedure:  

! To import the Collection Database, run bzbs_import_blazent_db.bat 
from the Oracle bin\blazent directory (for example, 
C:\oracle\ora<release>\bin\blazent). The blazent_db.dmp 
file must exist in the same directory with the same name.

! To import the Data Warehouse, run bzbs_import_blazent_dw_db.bat 
from the Oracle bin\blazent directory (for example, 
C:\oracle\ora<release>\bin\blazent). The 
blazent_dw_db.dmp file must exist in the same directory with the same 
name.

Note: Importing overwrites existing data, and may cause invalid data 
if not done properly. If you import over an existing database, all 
previous data is lost. This procedure should only be performed to 
restore a database that was backed up, or to duplicate an instance for 
troubleshooting purposes.
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Using Blazent Analytics

The Blazent Analytics web application displays interactive reports that allow IT 
professionals to understand the hardware and software deployments within an 
organization. 

This chapter introduces this application, and describes various features that appear 
throughout the Analytics web interface. For more detailed information about the 
features that are described here, or for information on specific reports, see the 
Blazent Analytics Online Help.

Opening Blazent Analytics

To open Blazent Analytics:

1. Use Internet Explorer to open the following URL:

http://<AnalyticsServerName>/blazent

where <AnalyticsServerName> is the name of your Analytics Server. 

2. Enter a valid User name and Password, and click Login.

If your system administrator has enabled the Guest user, you can click the Log 
In as Guest link to log in as an anonymous user. When you do, you are subject 
to the permissions established for this user as set by the administrator. See 
“Using Blazent Analytics as the Guest User,” on page 102 for more 
information.
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Chapter 6: Using Blazent Analytics
Using Blazent Analytics as the Guest User

When accessing Blazent Analytics through the Guest user account, all 
modifications and requests are saved only for the duration of the session. Different 
Guest users are identified by session ID so that no Guest user can view the History 
List from any other Guest user session. When a Guest user terminates a Web 
session, Blazent Analytics releases all data associated with that session.

Although the Guest user is treated differently, the security settings for this user are 
configured in the same way as for other users. The permissions granted to the 
Guest user are determined by the administrator.

Blazent Analytics Application Window

The Blazent Analytics Application window (Figure 8, on page 103) is composed of 
the following areas:

! The Toolbar, located in the blue band at the top of the screen, allows you to 
access report creation and subscription tools, and preferences. 

! The Quick Search box, located in the grey area under the toolbar on the left, 
allows you to search for reports either in the Blazent Analytics or My Reports 
folders.

! The left side bar provides access to the View Mode preference and Blazent 
Analytics online help.

! The main navigation window displays the contents of the area that you are 
currently viewing (often report directories or a report or document).
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Blazent Analytics Application Window
Figure 8:  Blazent Analytics Application Window
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Chapter 6: Using Blazent Analytics
The Toolbar

Table 19 displays descriptions of the toolbar buttons that appear at the top of the 
application window.

The Quick Search Box

Blazent Analytics allows you to search for folders, reports, and documents 
anywhere within a project:

! Simple Search allows you to search for objects (folders, reports and 
documents) by name in all folders, Blazent Analytics, My Reports, or in the 
folder currently open.

Table 19: Blazent Analytics Toolbar Options

Button Description

The Blazent Analytics application page from which you log in.

The Blazent Analytics online help system.

Logout A button that allows you to log out of the Blazent Analytics system.

Standard 
Reports

The default start page for Blazent Analytics.

My Reports A location that you can use for saving personal reports.

Create Report An area that allows you to define customized reports. 

My Subscriptions A list of all of the reports to which you have subscribed.

History List A list of the reports that were executed recently, with status information.

Preferences User preferences that allow you to customize the look, feel and functionality of 
your Blazent Analytics application.
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Blazent Analytics Application Window
! Advanced Search provides additional options, such as searching by object type, 
owner, description, or creation/modification date. 

To perform a quick search, type the report, folder, or document name (or part of 
the name) in the Quick search field at the top left of the page. If you are in either 
Standard Reports or My Reports, your search is limited to reports stored in that 
folder. If you are in another location (such as the History List or the Preferences 
page), Blazent Analytics searches the entire project. 

View Mode

When you select Standard Reports, My Reports, or My Subscriptions from the 
toolbar, the left side bar displays the View Mode heading, where you can specify 
how the reports in this area should be displayed:

! Select List view to display objects in a list. This view does not require as much 
screen space.

! Select Large Icons to display objects with large icons.

You Are Here

While you are browsing folders, Blazent Analytics displays the full folder path on 
the top of your page. You should see You are here: followed by the folder path. You 
can navigate to any folder in the path by clicking the name of that folder in the 
path. 

Note: By default, Blazent Analytics limits the maximum number of 
reports, documents, and folders returned in any search to 50.

Note: In the History List and Preferences pages, the You are here: 
folder path is replaced by a Return to: link, which allows you to return 
to the last folder visited or to the last report or document displayed.
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Chapter 6: Using Blazent Analytics
My Reports

The My Reports folder (available from the toolbar) is the location that you can use 
for saving personal reports. Under My Reports, you can also create subfolders to 
organize your reports.

You may not have access to the My Reports folder if: 

! You are logged in as the Guest user. 

! Your administrator has imposed restrictions on users or user groups regarding 
access to the My Reports folder. 

Create Report

The Create Report area of Blazent Analytics allows you to define a customized 
report either with the Report Builder or the Report Wizard.

! The Report Builder allows you to build a new Blazent Analytics report by 
defining your own report attributes, metrics, and filters. 

! The Report Wizard allows you to build a new Blazent Analytics report by 
selecting from a collection of pre-built templates and filters. 

My Subscriptions

The My Subscriptions web page (available from the toolbar) lists each document or 
report to which you are subscribed. You can click on the icon next to the document 
name to view the most recent report or document results.

Each row of the subscriptions list specifies the following information:

! Name. The name of the report. You can click this link to open the most 
recently generated results.

! Personalized. Specifies whether the report is personalized with default prompt 
responses.

! Schedule. Specifies how often the report is executed.
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Blazent Analytics Application Window
Click Edit to change your subscription options. 

To delete a subscription for a report or document, select the checkbox to the right 
of the report and click Unsubscribe at the top of the section.

History List

The History List (available from the toolbar) displays messages about every report 
and document that was executed in Blazent Analytics. Each message shows the 
status of the request and other identifying information, such as the report or 
document name, and the time at which the message was created: 

! A status of Ready means that a report or document has been fully executed. 
Click the report or document name in the History List to view it. 

! A status of Error means that the report or document did not execute 
successfully. Click the report or document name to display the error page.

If the report or document is either not ready or not in error, click the report or 
document name to be directed to the wait page, where you can further track the 
status of your request. 

If a plus sign (+) is displayed to the left of a document message, click it to see the 
underlying children reports for that document. 

Note: Reports do not remain in the History List indefinitely. The 
number of reports that each user can have in the History List and the 
length of time that the reports remain there can be controlled by the 
administrator.
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Chapter 6: Using Blazent Analytics
Preferences

User preferences (available from the toolbar) allow you to customize the look, feel 
and functionality of Blazent Analytics. You can set preferences in the following 
areas:

! General. Controls DHTML, start page, language, and accessibility settings.

! Grid display. Controls default display options for report grids.

! Graph display. Controls default display options for report graphs.

! Print. Controls default settings for printing reports.

! Export. Controls default settings for exporting reports.

! PDF. Controls defaults settings for producing PDF versions of reports.

! Drill mode. Controls whether to always keep or hide the parent report when 
drilling down.

! Prompts. Controls whether application prompts are displayed one step at a 
time, or all at once.

! Logout. Controls the handling of running reports and report histories when 
you log out of Blazent Analytics.

! Change my password. Allows you to change the password that you use to log 
into Blazent Analytics.

Using Reports

Blazent Analytics reports are powerful tools that allow you to analyze and 
understand the software and hardware needs of your organization. Through the 
approximately 75 reports that are available in the Standard Reports directories, you 
can access thousands of additional reports by drilling into the data through the 
links that are provided.

For example, starting from the PC Inventory Analysis report which displays  
counts of the numbers of desktop and laptop PCs in your organization, you could 
drill-down until you uncovered details about an individual hardware device on a 
single machine in that group.
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Using Reports
You can also refine reports by moving data columns to different locations in a 
grid,and by filtering out data that does not interest you. All report data can also be 
sorted on any report column.

Reports Start Page

The Standard Reports start page includes six directories of reports that allow you 
to analyze and understand the software and hardware needs of your organization. 
Reports are organized into the following directories:

! Blazent CIO. Executive overviews of the software and hardware needs of your 
organization.

! Blazent Assets. Reports that provide limited information about all machines 
on your network, including those without installed Blazent Agents.

! Blazent Help Desk. Reports that profile server and software usage by user.

! Blazent PCs. Reports on the personal computers used by individuals in your 
organization.

! Administration. Diagnostics of your Blazent Analytics application, including 
agent, user, data warehouse, and software categorization reports.

! Blazent Servers. Reports on the servers in your organization.

For complete information on specific reports, see the Blazent Analytics Online Help.
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Chapter 6: Using Blazent Analytics
Reports and Documents

Blazent Analytics reports are executed either as reports or documents:

! Reports are displayed as a single grid or graph. All drilling options and menus 
are available.

! Documents are used to display multiple reports on the same page. Documents 
include the default drill links (when available), but do not offer the other drill 
options or menus. You must navigate to a report version of the document for 
those features to be available (click the link at the bottom of the report area in 
the document page).

Executing Reports

To execute a report, click the name of the report either while browsing through the 
Standard Reports, My Reports, or History List directories, or when viewing a 
document with multiple reports. 

When a report is executing, a Wait page is sometimes displayed if results are not 
immediately returned. The Wait page contains the report or document name and 
its current execution status. When your report or document is ready, the report 
results page automatically replaces the wait page. You can perform the following 
actions while viewing the Wait page:

! Check Status Again. Manually refreshes the status of the Wait page. The page 
normally refreshes itself about every five seconds.

! Add to My History List. Adds information regarding the execution status of this 
report to your History List. You can browse to other areas of the application 
while the report executes, and return to the report results by accessing the 
History List page at a later time.

! Cancel this Request. Cancels the report during execution and returns you to 
the folder from which you made the request.
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Using Reports
Saving Reports

Blazent Analytics allows you to make changes to reports and save them for easy 
access at a later time. To save a report: 

1. In the current report, click the Save icon. The Save page opens with the 
original report name as the default in the Save report as field. 

2. For the Save report within option, select the location in which you want to save 
your report. Choose Standard Reports or My Reports (depending on your user 
privileges), and browse to any folder under one of these locations. The default 
location is the folder from which you selected the current report. 

For example, if you are saving a report that was located in the Blazent PCs 
folder, the default location is Blazent PCs. 

If you wish to create a new folder for your saved report, enter a name for the 
folder in the Create a new folder text box and click Create Folder. The new 
folder appears under Save report within.

3. In the Save report as field, enter a report name. To save the original report 
with any changes you might have made, leave the default name. To save the 
report as a new, distinct report, enter a new name in this box. 

4. In the Description text box, you can enter a description of your report. 

5. If you are saving a prompted report, select one of the Save prompt options: 

! Save the report as a static definition. If you select this option, the report is 
saved with the current template and filter information. Upon executing 
the report, you are not prompted again. 

! Save the report with any prompts embedded in the filter. If you select this 
option, the report is saved with the current template intact. Upon 
executing the report, you are prompted for the filter information only. 

! Save report with all the embedded prompts. If you select this option, you are 
prompted on all the original prompts, with your last selections saved as 
default values. 

! Save modifications to report filter. If you modify the report filter of a 
prompted report, this option attempts to save those manipulations in 
addition to the prompts. Because some manipulations may depend on the 
answers given to the prompts, some prompt questions may not be saved. 
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Chapter 6: Using Blazent Analytics
! Embed filter and template into saved report definition. The report is saved 
with the filter and template embedded into the definition of the report. 
When selected, the new report will not access the report cache of the 
original report, even if the original definition included a linked filter and 
template.

Note: You are only prompted on the template if you have object prompts 
associated with your report. If there are no object prompts, or if the 
template is static, the behavior appears to be the same as Save report and 
prompt on filter only.

6. Click Save Report.

 

Subscribing to Reports

You can choose to have a report or document automatically executed on a regular 
schedule or when a specific event occurs. After execution, the results are accessible 
in the History List or My Subscriptions web pages when you need them, without 
the wait time required for processing reports on demand.

To subscribe to a report or document: 

1. If you are viewing the report or document, select Report > Subscribe, or 
Document > Subscribe. 

If you have not yet executed the report and are viewing it in the Standard 
Reports or My Reports folder, click the Subscriptions link below the report icon 
(in Large Icons view), or in the Subscriptions column. A subscription panel 
displays. 

2. In the Choose a schedule field, select a schedule or event from the drop-down 
list.

Note: If you chose the name of a report that already exists in the 
selected folder, you are asked if you want to overwrite the original 
report. To save your changes, click Overwrite 
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Using Reports
3. If the report includes prompts, all prompts are displayed if you are not 
subscribing to an open report. The selections you make for these prompts are 
used whenever the subscribed report is run. 

4. Click OK. 

To make any changes to a saved subscription, use the My Subscriptions web page 
available from the toolbar.

Manipulating Report Format and Data

The power of the Blazent Analytics application lies in the multiple ways in which 
users can manipulate report format and data in order to customize information for 
various needs. This section summarizes the ways in which reports can be 
manipulated.

Displaying Grids and Graphs

Blazent Analytics allows you to view a report as a grid, a graph, or as both a grid 
and a graph simultaneously by choosing the appropriate option in the top-right 
toolbar or from the View menu:

! Click the Report Grid button or choose View > Grid to view the report as a 
grid only.

! Click the Report Graph button or choose View > Graph to view the report as a 
graph only.

! Click the Report Grid and Graph button or choose View > Grid and Graph to 
view the report as a grid and graph at the same time.

Formatting Graphs

The Graph Formatting toolbar allows you to change graph display settings. You 
can access the toolbar from the View menu by choosing Toolbars > Format. This 
option is only available when a graph is displayed. 
Blazent Confidential  113

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Chapter 6: Using Blazent Analytics
Formatting Grids

The following methods can be used to format grids: 

Autostyles

You can format grids with a pre-defined set of formatting options by choosing an 
Autostyle. To select an Autostyle:

1. If it is not already displayed, access the Report toolbar from the View menu, by 
selecting Toolbars > Report. 

2. Select a new style from the Autostyle drop-down list. The report automatically 
updates with the new style.

Merging Column Headers

Blazent Analytics allows you to either show all column header values or merge 
those that are repeated. For example, if three metrics on the report are related to 
the Sales department, do you want all three columns to have Sales in the header or 
merge the column headers? If merged, Sales appears only once for the three related 
columns.

To merge column headers for a report, from the Format menu, choose Merge 
Column Headers.

This preference is stored with the report definition. You can also set it for all 
reports in Grid Display user preferences. 

Banding

You can apply alternating background colors for rows on a report (banding). If a 
report is saved, the current banding setting is saved along with the report 
definition. Note that the current setting is overridden if the Autostyle is changed 
(each Autostyle has banding turned on or off by default). 

To show banding, from the Format menu, select Show Banding. 
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Using Reports
Outline Mode

Outline mode allows you to expand and collapse sections of data to control what 
portion of the report to view. To view a report in outline mode, from the Format 
menu, choose Outline. 

With most reports, small plus sign icons appear to the left of each header in the 
left-most column. You can click these plus signs to expand the data for that header, 
and then click them again to re-collapse the data.

Above the left-most column header numbered buttons are also displayed, one for 
each outline level. To expand a specific level of the report and all levels above it, 
click the button with the number for that level. The top-most level is assigned the 
number 1.

For example, to expand all levels and show all detail in the report, click the button 
with the highest number. To collapse all levels in the report except the top level and 
show only summary data in the report, click the button with the lowest number. 

Manipulating Report Data

You can move an object, such as a metric or attribute, on a report to change the 
report's layout. (This is sometimes called pivoting.) Depending on whether 
DHTML is enabled in your user preferences, there are several ways to do this: 

! Click on the object's header and drag it to the new location on the report or to 
the Page-by area above the report. The positions where it can be dropped are 
highlighted while you drag it. 

! Right-click on the object's header and select Move. Then select the desired 
option.

! If pivot buttons are displayed, click the button representing the direction in 
which you wish to move the object. 

Note: Outline mode works only if DHTML is enabled.
Blazent Confidential  115

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Chapter 6: Using Blazent Analytics
Sorting Data

You can sort any column of data in a report by clicking the column header. 
Choosing a column to arrange its values in ascending or descending order 
rearranges data in all of the columns appropriately.

To sort a report by a column: 

! If DHTML is enabled and the Show pivot buttons are not displayed, right-click 
the column header and select Sort > Ascending or Sort > Descending. 

! If the Show pivot buttons are displayed: 

Sorting Data by Multiple Columns

You can sort a report by up to three columns. For example, in a report that shows 
license cost within multiple departments, you could sort first by department then 
by cost. This allows you to see the most costly departments. To do this: 

1. From the Data menu, select Sort. The Sort panel is displayed. Select the first 
column name to sort by from the drop-down list, and whether to sort it in 
ascending or descending order. 

2. Select the second and third columns (optional) as in the previous step.

3. Click Apply to view the report with these sorting selections. 

Not sorted. Click this button to sort the data in descending order. 

The column is sorted in ascending order. If you click this button, the data is 
resorted in descending order. 

The column is sorted in descending order. If you click this button, the data is 
resorted in ascending order.
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Using Reports
Filtering on Selections

You can set whether rows or columns of information should be kept on or 
removed from a report by filtering. For example, if a report has more rows of 
information than you wish to view, you can specify which ones to keep and which 
to discard. To do this:

1. From the Data menu, select Filter on Selections... The report appears with a 
check box for each column and row in the report. 

2. Select those rows and columns that you wish to keep on the report. 

3. In the Filter on Selections panel above the report, click Filter. The report is 
displayed with only the elements you selected. 

Pivot Buttons

Pivot buttons allow you to manipulate report data by moving an attribute or metric 
in a specified direction: 

To show/hide pivot buttons, from the View menu, select Show Pivot buttons. 

Move to the left  Move to the right 

Move up Move down

Moves row headers to 
column headers in a new row.

 Moves column headers to row 
headers in a new column. 

Moves the object to the 
Page-by axis.

Moves the object out of the Page-
by axis into the columns of the 
report.
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Chapter 6: Using Blazent Analytics
Page By

Page-by allows you to break up a large report into smaller, more manageable 
sections, by placing one or more attributes and metrics from a report onto a "third 
axis." Much as you can move from worksheet to worksheet in Microsoft Excel, you 
can move from value to value of the page-by attribute to view only that portion of 
the data on a single screen.  

For example, if you are viewing a report that shows Hardware Peripherals and 
Computers, you can place Computer on the Page-by axis, and view the Peripherals 
for one computer at a time. 

To place an attribute or metric in the Page-by axis, do one of the following: 

! Right-click on the attribute or metric header and select Move > To Page Axis.

! Drag the attribute or metric header to the Page-by box above the report. The 
Page-by area is highlighted to indicate when you can drop it. 

! If enabled, use Pivot buttons. 

When an item is placed in the Page-by area, the item's name is displayed with a 
drop-down list containing its available values. The report shows only the data 
related to the value selected in the drop-down list. 

Drilling

Drilling allows you to navigate to different levels of information within a report. 
You can drill from one level of information to lower or higher levels of detail.

For example, if you are viewing a report with Department, Job Title, and Employee 
categories, and you run a report that shows only the Job Title category, you can drill 
down from Job Title to see the data for individual employees with that job. 
Conversely, you can drill up from Job Title to view information about the whole 
department to which employees with that job title belong.

Note: There can be multiple attributes and metrics in the Page-by 
axis at a single time.
Blazent Confidential 118

 



Pr
el

im
in

ar
y 

D
ra

ft
 In

te
rn

al
 U

se
 O

nl
y

Using Reports
This hierarchical relationship is sometimes referred to as a parent-child 
relationship. In the preceding example, Department is the parent of Job Title, Job 
Title is the child of Department and the parent of Employee, and Employee is the 
child of Job Title.

To drill in a report:

! To view the basic Drill area, from the Data menu select Drill. You can also right-
click anywhere in a report grid to view the same options. 

! To access the Advanced Drill area, right-click an object and select More 
options...

! To drill to the default option for a particular entry in a grid report, click any 
link that appears in the report grid. If you place the mouse pointer over the 
link, a tooltip displays the drill location. If an element is not displayed as a link 
it does not have a default drill option.

Drilling-Down on Compound Metrics

Another type of link drilling appears if compound metrics exist in the report. You 
can click the Metrics column header and break down the compound metrics to 
their simple metrics. This action is the same as performing a simple drill and 
selecting Drill to child metrics with no rows or columns selected.

Drilling on Graphs

If a report is formatted as a graph, you can drill to different levels of data by 
clicking directly on the graph itself or on its text labels. This action displays a new 
graph based on the default drill action defined by the report designer:

! Clicking a graph element (such as a bar in a bar graph) is similar to drilling on a 
row and column in a grid report. 

! Clicking an X axis label is the same as clicking a row in a grid report. 

! Clicking a Legend label is the same as clicking a column in a grid report. 

If there is no valid drill path for the portion of the graph you clicked, the original 
graph reappears.
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Chapter 6: Using Blazent Analytics
Displaying Totals

A report can have totals and subtotals defined for it and saved as part of the report 
definition. You can add additional totals to the report, toggle totals on or off (once 
they have been added), and remove them permanently.

To add totals to a report, from the Data menu, select the name of the desired 
"function" (such as Total, Max, Min, Count, and so on), then select one of these 
choices: 

! All Subtotals. Displays subtotals at all attribute levels, including grand totals.

! Grand Totals Only. Displays just the Grand Totals at the bottom right of the 
grid.

Blazent Analytics Online Help

As you work with Blazent Analytics you can quickly obtain information about the 
web page that you are currently viewing by using the context-sensitive help 
available in the application. This help system includes additional information about 
using and configuring Blazent Analytics that is not provided in this manual.

Access context-sensitive help by clicking the Need Help? link in the left side bar of 
most pages, or the ? icon in the top toolbar.

Blazent Analytics Online Help is designed to be viewed on all platforms, including 
Windows, Macintosh, and UNIX, with:

! Internet Explorer 5.0 or later

! Netscape Navigator 4.0 or later

The Help Viewer Window

Blazent Analytics online help is displayed in a web browser window. You can use 
built-in web browser functionality, such as the Back button, to navigate through 
topics in your project. 
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Blazent Analytics Online Help
You can open or close the left side bar, depending on how you like to work. When 
you close the side bar, the right-hand pane is maximized so you can see as much 
topic content as the size of your browser window allows.

To hide the left side bar, click the X icon in the upper right corner of the side bar 
area.

To open the left side bar, move your mouse to the small area between the help 
viewer and the side of the browser window. When your mouse icon changes into a 
two-sided arrow, click and drag the edge of the help viewer to the right until the left 
side bar is revealed.

Online Help Toolbar

The toolbar that is displayed at the top of the online help viewer includes the 
following features:

! Contents. This tab displays books and pages that represent the categories of 
information in the online help system. When you click a closed book, it opens 
to display its contents (sub-books and pages). When you click an open book, it 
closes. When you click pages, you select topics to view in the right-hand pane 
of the Help viewer.

! Index. This tab displays a multi-level list of keywords and keyword phrases. 
Keywords are cross-referenced with synonyms to provide multiple ways to 
locate information.

To open a topic associated with a keyword, click the keyword. If the keyword 
is used with more than one topic, a pop-up menu opens so that you can select 
a specific topic to view.

! Search. This tab enables you to search for words in the help system and open 
topics containing those words. Full-text search reviews every word in the 
online help to find matches and then lists the matches alphabetically.

! The -Search- Text Box. This text box allows you to perform a search without 
first opening the Search tab. When you enter a search string and click Go, the 
Search tab is opened with the results of your query. 
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Chapter 6: Using Blazent Analytics
Navigating Topics

Topics in the Blazent Analytics online help system include navigation components 
including:

! Related Topics buttons. When you click a Related Topics button, a pop-up 
menu opens that displays a list of topics that you can view. These topics are 
relevant to what you are currently reading in the right-hand pane or they cross-
reference related information. Click a topic from the pop-up to open it in the 
right-hand pane.

! Embedded links. Many topics include links that are embedded in the topic 
text. Click the link to open a different topic with related information.

Browse Sequences

You can easily move forward and backward through any series of topics by using 
the right and left arrow buttons in the top left corner of the left side bar. Topics are 
displayed in order of their appearance in the table of contents.

Full-Text Search

To use the full-text search feature of the online help, select the Search tab in the 
online help toolbar and enter your query in the search text box. The rules for 
formulating queries are:

! Searches are not case-sensitive, so you can type your search in uppercase or 
lowercase characters.

! Searches can use any combination of letters (a-z) and numbers (0-9).

! Punctuation marks such as the period, colon, semicolon, comma, and hyphen 
are ignored during a search.
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Blazent Analytics Online Help
! Elements of your search should be grouped with double quotes or 
parentheses to set apart each element. You cannot search for quotation marks. 

! If you are searching for a file name with an extension, you should group the 
entire string in double quotes, ("filename.ext"). Otherwise, the period will 
break the file name into two separate terms. The default operation between 
terms is AND, so you will create the logical equivalent to "filename AND ext."
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Chapter 6: Using Blazent Analytics
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Database Schema

This appendix describes the physical schemas of the Collection Database and Data 
Warehouse databases.

Tablespace Overview

The Collection Database and Data Warehouse tables are divided into tablespaces 
based on the volatility of the data the tables contain. Volatility categories include:

! Static and low-growth dimension data

! Moderate-growth dimension data

! High-growth dimension data

! Utilization data

The database installer sets the default location for all tablespaces in the same 
directory as the Oracle SYSTEM tablespace. Once installation is complete, the 
Blazent database creation scripts can be manually modified before any batch files 
are executed to either change the location of the tablespace data files, or to modify 
the extent parameters based on projected data volumes and growth. 

Use the following scripts to modify the data file locations and extent sizes:

! bzc_create_db.sql (Collection Database creation script)

! bzw_create_db.sql (Data Warehouse creation script)
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Chapter A: Database Schema
Collection Database Schema

Table 20 lists tablespace and data file names for the Collection Database.

Table 21 lists table names for the Collection Database, as organized by tablespace.

Table 20: Collection Database Tablespaces and Data File Names

Description Tablespace Name File Name

Static and low-growth 
dimension data

BZC_DIMENSION_STATIC BZC_DIMENSION_STATIC_01.DBF

Static and low-growth 
dimension indices

BZC_DIMENSION_STATIC_
IDX

BZC_DIMENSION_STATIC_IDX_
01.DBF

Moderate-growth 
dimension data

BZC_DIMENSION_MODERATE BZC_DIMENSION_MODERATE_
01.DBF

Moderate-growth 
dimension indices

BZC_DIMENSION_
MODERATE_IDX

BZC_DIMENSION_MODERATE_IDX_
01.DBF

High-growth dimension 
data

BZC_DIMENSION_HIGH BZC_DIMENSION_HIGH_01.DBF

High-growth dimension 
indices

BZC_DIMENSION_HIGH_IDX BZC_DIMENSION_HIGH_IDX_
01.DBF

Hourly utilization data BZC_FACT_UTILDATA_TS1 BZC_FACT_UTILDATA_TS1_01.DBF

Hourly utilization indices BZC_FACT_UTILDATA_IDX BZC_FACT_UTILDATA_IDX_01.DBF

Table 21: Collection Database Table Names
(1 of 3)

Tablespace Name Table Name

BZC_DIMENSION_STATIC ADMIN_CATEGORY_RULECLASS

BZC_DIMENSION_STATIC ADMIN_CATEGORY_RULESET

BZC_DIMENSION_STATIC ADMIN_SERVER_REG
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Collection Database Schema
BZC_DIMENSION_STATIC BZC_DATA_CLEANING

BZC_DIMENSION_STATIC BZC_DIAGNOSTICS

BZC_DIMENSION_STATIC BZC_DIAGNOSTICS_DATA

BZC_DIMENSION_STATIC BZC_MANUFACTURERS

BZC_DIMENSION_STATIC CPU_INFO

BZC_DIMENSION_STATIC DEPARTMENTS

BZC_DIMENSION_STATIC EMPLOYEE_POSITIONS

BZC_DIMENSION_STATIC HARDWARE_CATEGORIES

BZC_DIMENSION_STATIC LOCATIONS

BZC_DIMENSION_STATIC MACHINE_CATEGORIES

BZC_DIMENSION_STATIC MAC_VENDOR_MAPPING

BZC_DIMENSION_STATIC OS_FAMILIES

BZC_DIMENSION_STATIC OS_NAME_MAPPING

BZC_DIMENSION_STATIC PERSONNEL_STATUS

BZC_DIMENSION_STATIC SCHEMA_INFO

BZC_DIMENSION_STATIC SOFTWARE_CATEGORIES

BZC_DIMENSION_STATIC SOFTWARE_LICENSES_PURCHASED

BZC_DIMENSION_STATIC USER_MACHINE_PROFILES

BZC_DIMENSION_MODERATE MACHINES

BZC_DIMENSION_MODERATE MACHINE_CATEGORY_MAP

BZC_DIMENSION_MODERATE MACHINE_INFO

BZC_DIMENSION_MODERATE OS_ENTRIES

Table 21: Collection Database Table Names
(2 of 3)

Tablespace Name Table Name
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Chapter A: Database Schema
BZC_DIMENSION_MODERATE SW_PACKAGE_ITEMS

BZC_DIMENSION_MODERATE TEMP_CAT_SW_PACKAGES

BZC_DIMENSION_MODERATE USERS

BZC_DIMENSION_MODERATE USER_MACHINES

BZC_DIMENSION_HIGH ASSET_INFO_ENTRIES

BZC_DIMENSION_HIGH DISCOVERED_ASSETS

BZC_DIMENSION_HIGH HARDWARE_ENTRIES

BZC_DIMENSION_HIGH HARDWARE_ITEMS

BZC_DIMENSION_HIGH MACHINE_CATEGORY_FAMILIES

BZC_DIMENSION_HIGH SOFTWARE_ENTRIES

BZC_DIMENSION_HIGH SOFTWARE_ITEMS

BZC_DIMENSION_HIGH SW_PACKAGE_ENTRIES

BZC_DIMENSION_HIGH TEMP_CAT_HOUSE_KEEPER

BZC_DIMENSION_HIGH TEMP_CAT_SW_ITEMS

BZC_DIMENSION_HIGH USER_SESSIONS

BZC_FACT_UTILDATA_TS1 UTILIZATION_ENTRIES

Table 21: Collection Database Table Names
(3 of 3)

Tablespace Name Table Name
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Data Warehouse Schema
Data Warehouse Schema

Table 22 lists tablespace and data file names for the Data Warehouse.

Table 22: Data Warehouse Tablespaces and Data File Names

Description Tablespace Name File Name

Static and low-growth 
dimension data

BZW_DIMENSION_STATIC BZW_DIMENSION_STATIC_01.DBF

Static and low-growth 
dimension indices

BZW_DIMENSION_STATIC_
IDX

BZW_DIMENSION_STATIC_IDX_
01.DBF

Moderate-growth 
dimension data

BZW_DIMENSION_MODERATE BZW_DIMENSION_MODERATE_
01.DBF

Moderate-growth 
dimension indices

BZW_DIMENSION_
MODERATE_IDX

BZW_DIMENSION_MODERATE_IDX_
01.DBF

High-growth dimension 
data

BZW_DIMENSION_HIGH BZW_DIMENSION_HIGH_01.DBF

High-growth dimension 
indices

BZW_DIMENSION_HIGH_IDX BZW_DIMENSION_HIGH_IDX_
01.DBF

Temporary tables BZW_TEMP_TABLES BZW_TEMP_TABLES_01.DBF

Daily utilization data BZW_FACT_UTILDATA_DAY_
TS1

BZW_FACT_UTILDATA_DAY_TS1_
01.DBF

Monthly utilization data BZW_FACT_UTILDATA_
MON_TS1

BZW_FACT_UTILDATA_MONTH_
TS1_07.DBF

Miscellaneous utilization 
tables

BZW_FACT_UTILDATA_MISC BZW_FACT_UTILDATA_MISC_
01.DBF

Utilization indices data BZW_FACT_UTILDATA_IDX BZW_FACT_UTILDATA_IDX_01.DBF
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Chapter A: Database Schema
Table 23 lists table names for the Data Warehouse, as organized by tablespace.

Table 23: Data Warehouse Table Names

Tablespace Name Table Name

BZW_FACT_UTILDATA_DAY_TS1 DW_CPU_UTIL_DAY

BZW_FACT_UTILDATA_DAY_TS1 DW_MEM_UTIL_DAY

BZW_FACT_UTILDATA_DAY_TS1 DW_SW_UTIL_DAY

BZW_DIMENSION_HIGH DW_DISCOVERED_ASSETS

BZW_DIMENSION_HIGH DW_DIS_ASSETS_HISTORY

BZW_DIMENSION_HIGH DW_DIS_ASSETS_INFO

BZW_DIMENSION_HIGH DW_HARDWARE_ENTRIES

BZW_DIMENSION_HIGH DW_HARDWARE_ITEMS

BZW_DIMENSION_HIGH DW_SOFTWARE_ENTRIES

BZW_DIMENSION_HIGH DW_SOFTWARE_ITEMS

BZW_DIMENSION_HIGH DW_SOFTWARE_PKG_ENTRIES

BZW_DIMENSION_MODERATE BZW_ERROR_LOG

BZW_DIMENSION_MODERATE BZW_PROCESS_LOG

BZW_DIMENSION_MODERATE DW_ASSETS

BZW_DIMENSION_MODERATE DW_SOFTWARE_LICENSES_PURCHASED

BZW_DIMENSION_MODERATE DW_SOFTWARE_PACKAGES

BZW_DIMENSION_MODERATE DW_USERS

BZW_DIMENSION_MODERATE DW_USER_ASSETS_JOIN

BZW_DIMENSION_STATIC BZW_DIAGNOSTICS

BZW_DIMENSION_STATIC BZW_DIAGNOSTIC_DATA

BZW_DIMENSION_STATIC BZW_KEYS
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Data Warehouse Schema
BZW_DIMENSION_STATIC BZW_SYNC_RUNS

BZW_DIMENSION_STATIC CATEGORY_RANGE

BZW_DIMENSION_STATIC DW_ASSET_TYPE

BZW_DIMENSION_STATIC DW_DATES

BZW_DIMENSION_STATIC DW_DEPARTMENTS

BZW_DIMENSION_STATIC DW_EMPLOYEE_POSITIONS

BZW_DIMENSION_STATIC DW_FUNCTIONS

BZW_DIMENSION_STATIC DW_HARDWARE_CATEGORIES

BZW_DIMENSION_STATIC DW_LOCATIONS

BZW_DIMENSION_STATIC DW_PERSONNEL_STATUS

BZW_DIMENSION_STATIC DW_ROLES

BZW_DIMENSION_STATIC DW_SOFTWARE_CATEGORIES

BZW_DIMENSION_STATIC DW_TIMES

BZW_DIMENSION_STATIC DW_USER_MACHINE_PROFILES

BZW_DIMENSION_STATIC T_MACHINE_DISK_RAM

BZW_FACT_UTILDATA_MISC DW_DISK_STORAGE_UTIL_MONTH

BZW_FACT_UTILDATA_MISC DW_MACHINE_RECENCY

BZW_FACT_UTILDATA_MISC DW_MACHINE_UTILIZATION

BZW_FACT_UTILDATA_MISC DW_SW_RECENCY

BZW_FACT_UTILDATA_MON_TS1 DW_CPU_UTIL_MONTH

BZW_FACT_UTILDATA_MON_TS1 DW_MEM_UTIL_MONTH

BZW_FACT_UTILDATA_MON_TS1 DW_SW_UTIL_MONTH

Table 23: Data Warehouse Table Names

Tablespace Name Table Name
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Chapter A: Database Schema
BZW_TEMP_TABLES TEMP_CLIENT_VERSION

BZW_TEMP_TABLES TEMP_HARDWARE_ENTRIES

BZW_TEMP_TABLES TEMP_MACHINES

BZW_TEMP_TABLES TEMP_MACHINE_INFO

BZW_TEMP_TABLES TEMP_MCH_CONFIG

BZW_TEMP_TABLES TEMP_MCH_CPU

BZW_TEMP_TABLES TEMP_MCH_CPU_BASE

BZW_TEMP_TABLES TEMP_MCH_DISK_RFM

BZW_TEMP_TABLES TEMP_MCH_FUNCTION

BZW_TEMP_TABLES TEMP_MCH_INSTALLED

BZW_TEMP_TABLES TEMP_MCH_MODEL

BZW_TEMP_TABLES TEMP_MCH_RAM

BZW_TEMP_TABLES TEMP_MCH_RFM

BZW_TEMP_TABLES TEMP_OS_ENTRIES

BWZ_TEMP_TABLES TEMP_UTIL

Table 23: Data Warehouse Table Names

Tablespace Name Table Name
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Troubleshooting

Terminal Services Recommendation

Do not use Terminal Services to install any server or Blazent Agent components. 
Terminal Services does not grant users the same permissions, nor does it update 
the registry in the same way that installing directly from a local machine does.

Oracle Issues

Pentium 4 Installation Issues

Oracle V. 8.1.7

The Oracle V. 8.1.7 installer has known problems installing on Pentium P4 
machines. In order to correct this, follow these additional steps:

1. Install the latest supported Windows 2000 Service Pack patch from:
http://www.microsoft.com/windows2000/downloads/servicepacks/
default.asp

2. Create a temporary directory on your Intel Pentium® 4 processor server (for 
example, \TEMP). 

3. Copy the contents of the Oracle Server CD to the temporary directory that 
was created in Step 2. 
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Chapter B: Troubleshooting
4. Search the directory structure that was created in Step 2 for all instances of the 
file SYMCJIT.DLL. 

5. Rename each copy of SYMCJIT.DLL to SYMCJIT.OLD. 

6. Run SETUP.EXE from the \TEMP\install\win32 directory and install 
Oracle 8.1.7. 

7. After the initial installation, install the Oracle Service Pack 4 patch. Make sure 
that you follow all instructions that are provided in the patch installation.

Intel has provided an article on this issue at http://support.intel.com/support/
processors/pentium4/issues.htm.

Oracle 9i 

The Oracle Internet File System configuration tool fails on Pentium 4 machines 
because symcjit.dll is incompatible with the installed version of the JRE.  To 
work around this issue, replace the symcjit.dll file in the 
ORACLE_HOME\ifs1.1\jre\bin directory with the symcjit.dll file in the 
<SYSTEM_DRIVE>\Program Files\Oracle\jre\1.1.8\bin directory.

Oracle Services Still Running After Uninstall

If you uninstall Oracle, verify that all Oracle services are removed. If 
OracleOraHome81Agent was not removed, do the following before reinstalling 
Oracle:

1. Navigate to C:\oracle\ora81\network\agent and remove all files with 
the .q extension.

2. Restart the server.
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Analytics Server/MicroStrategy Issues
“TNS No Listener” Error When Connecting Through 

Oracle Management Tools

A “TNS No Listener” error may occur in new Oracle installations when 
connecting through Oracle Management tools for the following reasons:

! The C:\oracle\ora81\network\ADMIN\TNSNAMES.ORA  file includes 
typos in the port number value, or in the database or domain name.

! The C:\oracle\ora81\network\ADMIN\listener.ORA  file 
includes typos in the port number value, or in the database or domain name.

! The OracleOraHome81TNSListener service is stopped or is not running 
properly.

To work around this issue, fix the typos and/or stop and restart the 
OracleOraHome81TNSListener service in the Windows Services dialog box.

Analytics Server/MicroStrategy Issues

To troubleshoot the Analytics Server for errors, you can use the Windows Event 
Viewer:

1. Open the Event Viewer from the Windows Start menu by choosing Settings > 
Control Panel > Administrative Tools > Event Viewer.

2. Open the Application Log.

3. Sort the Source column and view errors for MSTRServer and the 
Microstrategy Service Manager.

Most configuration issues relate to the connections between the Data Warehouse 
and the Analytics Server. You can use the sample application that ships with 
MicroStrategy to test basic report and web connectivity.
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Chapter B: Troubleshooting
MicroStrategy Intelligence Service Does Not Start

If you cannot start the MicroStrategy Intelligence Service from the Windows 
Service dialog box, it may be for one of the following reasons:

! The Data Warehouse is not running, even though the listener service is 
running. Use the Oracle Srvcmgr program to start the database.

! The service does not start automatically during start up. In the Windows 
Services dialog box, set the service Start Up Type property to Manual so that 
the machine does not attempt to start the service during start up. You must 
start the service manually or create an administrator logon script to start it.

! The wrong user is used to log into the MicroStrategy service.  Open the 
Services dialog box, right-click MSTR Intelligence Server and choose 
Properties. In the Logon tab verify that the specified user is the 
LocalSystemAccount.

MicroStrategy Desktop Does Not Connect to the 

Data Warehouse

If MicroStrategy Desktop does not connect to the Data Warehouse, it may be 
because the ODBC System DSN includes a period with the database name (for 
example, ‘maindb.’). 

Workaround

Open the ODBC dialog box from the Windows Control Panel, remove the period, 
and test the ODBC connections.
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Collection Server Issues
Collection Server Issues

Collection Server logs are stored in the \BlazentServer\logs directory, and 
are named logging<n>.txt (for example, logging32.txt) Log files are 
required to troubleshoot the Collection Server. When viewing Collection Server 
log files, look for FATAL and ERROR log messages.

Monitor the size of files named logging.txt.# and 
networklogging.txt.#, since they can grow to 50MB or larger. You may wish 
to periodically archive and delete these files.

PowerUpdate Issues

The PowerUpdate log file (PULog.txt) is created by the PowerUpdate client and 
stored in the blazent/update folder.  Relevant information is generally found 
in the last 10 lines of the file. If PULog.txt does not exist, LHUpdate has not 
called the PowerUpdate client.

LHUpdate Does Not Run (PULog.txt Does Not Exist)

If PULog.txt does not exist, LHUpdate has not called the PowerUpdate client. 
This issue occurs because of a possible error in configuration.xml. To work 
around this issue, verify that the LHUpdate TSI is correct and that it is not set to 
be less than CommandListRefresh TSI.

Update Process Never Ends on Windows NT 4

The update.exe process never ends on Windows NT 4 due to the absence of a 
locally installed JRE. Verify that there is a JRE folder inside the update folder 
when distributing the Agent installer and/or adding to the PowerUpdate server. 
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Chapter B: Troubleshooting
Update Fails to Run on Windows

The update process cannot run on Windows machines if it cannot find the JRE. If 
this issue occurs you must use the customized update.lax that contains the 
proper path to java.exe. 

Update Fails to Run on Unix

The update process cannot run on Unix machines if:

! the ^M character occurs in one or more files. Windows uses CRLF, but UNIX 
uses only LF. To avoid this issue, verify that Unix text files are never saved in a 
Windows environment. To remove ^M characters, use:
tr -d '\15\32' < winfile.txt > unixfile.txt

! files do not have executable permissions set. Verify that install-agent, 
install-agent-powerupdate, and update all have the executable 
permission set.

Agent Files Downloaded, But Not Installed

If the update executable runs and downloads a new client, but the Agent is not 
installed:

! the PowerUpdate server is incorrectly configured. Verify that there are no 
typos in your settings.

! SetupSilentPowerUpdate is missing on Windows, or install-
agent-powerupdate is missing on Unix. Verify that these files exist, and 
that install-agent-powerupdate has the correct path on Unix 
machines.
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Blazent Agent Issues
Directory Structure Disappears After Running 

Update (Unix)

After running the update executable, the directory structure may disappear 
because install-agent is sensitive to the location from which it is updated. 
Verify that PowerUpdate is set to execute install-agent-powerupdate.

Blazent Agent Issues

Agent Does Not Connect to Collection Server

A Blazent Agent does not connect to the Collection Server for the following 
reasons:

! The Blazent Agent’s bootstrap.xml file does not have the right server 
name or IP address for the s argument in the BZLogOnModule command 
section.

Edit bootstrap.xml so that it references the correct Collection Server. 
You must use the same format for the s argument as was used when initially 
installing the Collection Server. For example, if you used an IP address during 
Collection Server installation, you must use an IP address for the 
LoginServerAddress parameter. 

! The Collection Server's clientconfig.xml file does not have the right 
server name or IP address for the Collection Server (DCS parameter). 

Edit clientconfig.xml so that it references the correct Collection Server. 
You must use the same format for the DCS parameter as was used when 
initially installing the Collection Server. For example, if you used an IP address 
during Collection Server installation, you must use an IP address for the DCS 
parameter. 
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Chapter B: Troubleshooting
! The Collection Server name is not in WINS or in the corporate DNS and 
Agents cannot resolve the server name to an IP address. 

Either define the Collection Server IP address and name combination in the 
corporate WINS and DNS servers, or temporarily change all of the property 
files to use static IP addresses.

Access Issues

Blazent Analytics Password Expires

Blazent Analytics includes an administrative option that requires users to change 
passwords periodically. If an administrator has enabled this option, it is to ensure 
that the information that is accessible in the reports is secure. As a precaution 
against inadvertently revealing your password to others, you should change it 
periodically.

MicroStrategy License Expires

If your MicroStrategy license expires, you cannot access Blazent Analytics. After 
the MicroStrategy license is renewed, you will be able to run the Blazent Analytics 
application again. Contact Blazent Support for more information.
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Report Data Issues
Report Data Issues

Report Execution Fails

When data is being updated in the Data Warehouse, report data is temporarily 
unavailable. By default, the Data Warehouse is scheduled to be updated once an 
hour at the beginning of the hour. If you try to execute a report when the update is 
occurring, you might receive one of the following errors:

Error in report results. Your request could not be processed due to 
a server error. Please try again. If the problem persists, contact 
the server Administrator. -----------------------------------------
--------------------------------------- (The object given is 
embedded inside another object, so it is not visible to this 
object. QueryEngine encountered error: The report result cannot be 
displayed because it exceeds the maximum row limit in governing. 
32000 Error in Process method of Component: QueryEngineServer, 
Project 1, Job 430, Error Code= -2147467259. )

Error in report results. Your request could not be processed due to 
a server error. Please try again. If the problem persists, contact 
the server Administrator. -----------------------------------------
---------------------------------------(Error(s) occurred while 
loading report: DSSSQLEngine: converting Report : Template (Local 
Template). -Template Unit Metrics -Template Metrics -Dimensional 
Metric (Database Software). -Dimensional Metric -Dimensional Metric 
-Filter (Root Category #1). -Filter Unit -Filter Unit -Filter Unit 
-Filter Unit -Filter Entity -Expression -Attribute Forms -Base 
Attribute Forms COM interface error. . Error in Process method of 
Component: SQLEngineServer, Project 1, Job 440, Error Code= -
2147212797. )

Workaround

Wait a few minutes and try to execute your report again.
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Chapter B: Troubleshooting
“Request Time Out” Error

A “Request time out” error can sometimes occur if you open a report that uses a 
prompt that is populated by a large amount of data. If this issue happens repeatedly 
with your IT Intelligence Software installation, use the following steps to prevent 
the Analytics Server from timing out too quickly:

1. Access the Blazent Analytics administration page by opening the following 
URL:
http://<Your_Analytics_Server_Name>/blazent/admin/admin.asp

2. In the Web Server area on the left, set the Server busy timeout and Request 
timeout values to 600.

“Out of Memory” Error

A java.lang.OutOfMemoryError can sometimes occur when a user is running a 
report if the MicroStrategy Java heap size is too small.

Workaround

1. On the Analytics Server machine, open Regedit.

2. Navigate to HKEY_LOCAL_MACHINE\Software\MicroStrategy\JNI 
Bridge\Configuration\JVM Options.

3. Increase the value of the HeapMaxSize registry key to 256 Mb or larger. By 
default, this value is set to 128 Mb.

4. Use the Windows Services control panel to restart the following services:

! IIS

! World Wide Web Publishing Service

! MicroStrategy Intelligence Server 7
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Report Data Issues
Report Data is Missing, Fails to Return, or Displays 

as 1s and 0s

Data may be missing, not returned, or set to 1s and 0s if the data warehouse job is 
running when you execute your report. This job normally runs about once an hour.

If the warehouse job is not running, verify that your query is correct and can return 
valid data.

Limited Drill Options

You may not have any drilling options if there is no parent or child of the report 
that you wish to drill on. See “Drilling,” on page 118 for more information.

Filter Details Tab States "The Filter is Empty"

This is normal behavior that indicates that no additional filtering has been applied 
to the report.

Drill to None Option

The Drill to None option indicates that there is no template to which you can drill. 
Rather than using this advanced drilling technique, try using the hyperlink drill-
down or simple drilling function. See the Blazent Analytics Online Help for 
additional information on this option.
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Chapter B: Troubleshooting
Report Totals Do Not Add Up

Numbers might not add up in some reports for two reasons:

1. Some reports, such as Hardware Devices by Department, might list numbers 
of devices in subsets (departments) of a whole (enterprise). These subsets of 
data are sometimes listed more than once. For example, if the Human 
Resources Department shares a storage device with Finance, the device is 
included in each department's total as a separate entry, but is included in the 
report total only once.

2. Some reports reference numerical values that are not whole numbers. In these 
cases, Blazent Analytics rounds the figures, so your totals might not add up.

Report Display Issues

Grid Does Not Display Field Labels

To display grid field labels, enable the Show attribute forms preference:

1. Navigate to the Preferences area. 

2. Select Grid Preferences.

3. Enable Show attribute forms. 

Displaying Only Graphs, Only Grids, or Both

See “Displaying Grids and Graphs,” on page 113.

To always display both the grid and the graph view, enable the Show Graph/Grid 
option in Preferences > Graph.  

Note: Sometimes a graph cannot be displayed because the data in 
the report is not appropriate for a graph.
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Report Display Issues
"Insufficient Data to Display the Requested Chart 

Subtype" Report Display Error

This message is displayed because the selected chart type is not appropriate for the 
data.

Workaround

Try selecting a different chart subtype by clicking the Properties tab and selecting a 
value from the drop-down list in the report header. For example, if you receive this 
error for a Side by side graph, try a Stacked bar or Percent graph instead.

"Insufficient Data to Display a Graph" Report 

Display Error

This message is displayed because the report's data cannot be successfully 
translated to a graph. If you select the graph option for a report with data that 
requires more than one page to view, you cannot navigate beyond the first page. 

Workaround

Turn off the graph option to display the grid only, and then navigate to other pages.

Bar Charts Include a Bar for "Total"

This issue is a known limitation of the Report Server and has been reported to the 
third-party software vendor. 
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Chapter B: Troubleshooting
Workaround

Export the report to Excel and remove the total from the chart.

Graph Does Not Display All Data

If your report returns more data than can display on one page, the report displays 
on multiple pages. If this occurs, your chart includes only the data displayed in the 
grid on the same page. Navigating to the second page will display a new chart that 
applies only to the data on the second page. See “Page By,” on page 118 for more 
information.

Inappropriate Graph is Used for Data

Blazent Analytics includes different graph types to support the display of different 
types of data. For example, when you compare ratios, where all data represents 
different parts of a whole, a pie chart is a good visual representation of that data. 
However, if you are comparing subsets, a pie chart cannot represent the data. In 
this case, a bar or line chart will better represent the data.

Report Functionality Issues

Report Executes Slowly

Reports can take a long time to execute if large amounts of data need to be 
processed in order to generate results.
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Report Functionality Issues
Workarounds

! Check the parameters that you entered in the report prompt fields. For 
example, if you entered a date range that includes a large number of days, try 
to limit the date range to a smaller value. 

! Add the report to your History List by clicking Add to My History List in the 
Execute Report window. This action allows the report to continue executing 
while you do something else. You can retrieve the report from your History 
List when it is done. See “History List,” on page 107 for information.

! Create a subscription to the report so that Blazent Analytics will execute the 
report automatically, allowing you to retrieve it after it has been executed. See 
“My Subscriptions,” on page 106 for information.

Report Cannot Be Exported

The report that you are trying to export either exceeds the capacity of the 
spreadsheet or is larger than the row or column limit specified by your 
administrator. 

Workaround

Manipulate the report so that it fits within the spreadsheet. If this does not work, 
have your administrator change the maximum number of rows or columns that you 
can export. 

Attribute Form Labels Fail When Exported to 

Comma-Separated (CSV) Text

This issue is a known limitation of the Reports Server and has been reported to the 
third-party software vendor in an effort to address the issue. 
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Chapter B: Troubleshooting
Workaround

If you use attribute form labels, export to Excel or HTML.

Pressing Enter Does Not Execute Report After 

Entering Prompts

The Enter key is handled differently in different browsers.

Workaround

The fastest way to execute a report is to click the Execute button. Alternately, you 
can press the Tab key until the Execute button is highlighted, and then press 
Enter.

Report Cannot Be Sorted by Some Columns

If a column displays data values that bear no relation to one another, you cannot 
sort the column. 

Browser Back Button Does Not Work

This condition can occur if you use the browser Back button to navigate to the 
beginning of a report and it requires re-execution. 

Workaround

Use the built-in Blazent Analytics navigation features (such as clicking on the 
report path) to navigate backwards instead of using the Back button.
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Technical Support

The Blazent Technical Support organization provides support services for all 
current releases of Blazent products. Support staff are available Monday through 
Friday from 8:00am to 5:00pm Pacific Time, excluding holidays. 24/7 support 
packages are also available for an additional fee.

Blazent Technical Support has two main objectives:

! To assist customers in maintaining and/or regaining the operation of their 
Blazent software.

! To correct any underlying issues in the software or its configuration.

Scope of Service

The scope of technical support that is provided by Blazent includes:

! Problem Prevention. Blazent will notify all customers of the availability of new 
releases and patches for Blazent IT Intelligence Software.

! Problem Identification. Blazent will:

! clarify all Blazent error messages.

! assist in identifying and verifying the causes of suspected errors.

! provide workarounds for previously identified errors.

! Problem Resolution. Blazent will:

! report and track product defects and enhancement requests.

! provide notification of issue and escalation request status.

! resolve product defects with a workaround, maintenance release, or patch.
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Chapter C: Technical Support
Before Contacting Support

Before you open a case with Customer Support:

! Check the Blazent product documentation and online Knowledge Base.

! Gather a complete description of the problem, including any transaction logs, 
error messages, screen shots, and log files.

! Be prepared to summarize the steps that you have already taken to diagnose 
and solve the issue.

! Know the version number of the software that you are currently using, 
including all related third-party products such as MicroStrategy and 
Embarcadero.

! Identify any recent changes in hardware, software, or other maintenance that 
might have affected the application.

Contacting Customer Support

You can contact Blazent Customer Support through the following channels:

! Web site: http://support.blazent.com/

! E-mail: support@blazent.com

! Telephone: (650) 286-5588

Support Hours

Blazent provides two levels of availability for support issues, with additional 
coverage for all Priority 1 support cases. 

Note: Priority 1 support hours do not apply to issues with third-
party applications, unless the issue directly relates to the Blazent IT 
Intelligence Software application.
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Contacting Customer Support
Basic-Level Support

Customers with a Basic-level support contract can access technical support during 
normal business hours, from 8:30 AM to 5:30 PM Pacific Time.

Priority 1 support cases are handled 24-hours a day, Monday - Friday.

Premium-Level Support

Customers with a Premium-level support contract can access technical support 
according to the terms of the contract negotiated with Blazent. 

Priority 1 support cases are handled 24-hours a day, seven days a week (except for 
major US holidays).

Web Site Access

You can access the Blazent Customer Support Web site at: 
http://support.blazent.com/

This web site provides 24-hour-a-day access to:

! The current status of all open issues.

! The problem logging form (please follow up with a telephone call for all 
Priority 1 issues).

! The Blazent Knowledge Base, which contains product-related white papers, 
workarounds, and other documentation.

Access to the Support website is controlled by a username and password. If you 
have been added to the system, your username is your first initial followed by your 
last name. For example, if your name is John Doe, your username for the Support 
website is jdoe. Your password is your e-mail address.

Customers who have not yet been added to the Support website can log in as guest 
users by following the directions on the log-in page of the site. 
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Chapter C: Technical Support
Blazent welcomes all feedback on the presentation and content of our Support 
website and Knowledge Base. If you identify an inaccuracy, or if you believe there 
is a topic that needs more coverage, please contact Technical Support.

E-mail Access

You can e-mail Blazent Customer Support at: 
support@blazent.com

E-mail requests are answered during local business hours, as specified in “Support 
Hours,” on page 150. If you are submitting a Priority 1 issue, please follow up the 
e-mail with a telephone call to ensure a prompt response.

Use the Problem Logging Form as the template for your e-mail. You can find the 
Problem Logging Form as an appendix in the Blazent Administration or Installation 
Guide. 

Telephone Access

You can telephone Blazent Customer Support at
(650) 286-5588

If you are reporting a Priority 1 issue, please follow up the telephone call with an e-
mail that includes a full description of the problem.

Support Case Priority Level

Blazent strives to provide timely support to our customers. To help us understand 
the severity of your problem and to help us prioritize our work, we ask that you 
assign a priority to each issue as it is reported.

Table 24 describes the different priority levels for customer support issues, 
including response times. Two response times are indicated:
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Support Case Priority Level
! Acknowledgment. The maximum amount of time that it should take for Blazent 
to acknowledge that we have received your problem.

! Initial review. The maximum amount of time that is should take for Blazent 
Support to review the problem and present you with the next steps towards 
resolution.

Please use this table as a guideline for determining the priority of your own issues.

If Blazent does not agree with the assigned Priority level, the issue will be discussed 
with the customer and a mutually acceptable level will be used.

The response times shown in Table 24 are based on the time that Blazent 
Customer Support acknowledges receipt. In many instances, the response times 
are likely to be faster than those specified.

Table 24: Support Issue Priority Levels

Priority Level Description Response Times

1 “Production 
Down”

All production systems are inoperative 
or are experiencing severe performance 
degradation. No workaround is 
available. Software no longer provides 
any material benefit to your 
organization.

Acknowledgment: 1 business hour

Initial review: 4 business hours

Note: Priority 1 issues should be 
reported by telephone and 
immediately followed up with a 
detailed e-mail or web submission.

2 “Mission 
Critical”

System fails to satisfy critical functional, 
operational, or performance 
specifications. 

Acknowledgment: 3 business hours

Initial review: 6 business hours

3 “Serious” One part of the software is inoperative, 
causing or resulting in sub-standard or 
erratic performance. Nonetheless, 
remainder of software operates in 
accordance with specifications.

Acknowledgment: 5 business hours

Initial review: 8 business hours

4 “Problem” No part of the software is inoperative, 
and business impact is moderate or 
small. The software operates in 
accordance with specifications.

Acknowledgment: 8 business hours

Initial review: 10 business hours
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Chapter C: Technical Support
Escalation of Support Cases

Blazent is committed to ensuring efficient and effective resolution of issues 
through a defined internal escalation process. Table 25 describes the steps of this 
process for each priority level.

Table 25: Support Issue Escalation Process
(1 of 2)

Priority Level Escalation Point 1 Escalation Point 2 Escalation Point 3

1 “Production 
Down”

Time to notification: 
Immediate

Escalataion:

• Support Manager
• Professional Services 

Manager

Time to notification:
4 hours after Escalation 
Point 1

Escalataion:

• VP of Engineering 
and VP of Services

Time to notification:
8 hours after Escalation 
Point 2

Escalataion:

• Executive team 
notified

• Case receives daily 
executive review

2 “Mission 
Critical”

Time to notification: 
8 hours

Escalataion:

• Support Manager
• Professional Services 

Manager

Time to notification:
16 business hours after 
Escalation Point 1

Escalataion:

• Professional Services 
Manager

Time to notification:
16 business hours after 
Escalation Point 2

Escalation:

• Open case receives 
daily executive review 

• Case upgraded to 
Priority 1

3 “Serious” Time to notification: 
16 hours

Escalataion:

• Support Manager

Time to notification:
36 business hours after 
Escalation Point 1

Escalataion:

• Professional Services 
Manager

Time to notification:
36 business hours after 
Escalation Point 2

Escalataion:

• Weekly review by VP 
of Engineering and 
VP of Services
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Escalation of Support Cases
Priority 1 Issues

! The Support Manager and Professional Services Manager are notified 
immediately.

! After 4 hours, the VP of Engineering and VP of Services are notified.

! After 8 hours, the entire executive team is notified.

! After the issue has been open for 48 hours, the executive team reviews the 
problem daily until it is resolved.

Priority 2 Issues

! The Support Manager and Professional Services Manager are notified within 8 
hours of the case opening.

! After 16 business hours, the VP of Engineering and the VP of Services are 
notified.

! After 16 additional business hours, the entire executive staff is notified.

! After 40 hours, the case is escalated to Priority 1 and the executive team 
reviews the problem daily until it is resolved.

4 “Problem” Escalataion:

• Support Manager

Escalation:

• Professional Services 
Manager

Escalation

• Monthly review by 
VP of Engineering 
and VP of Services

Table 25: Support Issue Escalation Process
(2 of 2)

Priority Level Escalation Point 1 Escalation Point 2 Escalation Point 3
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Chapter C: Technical Support
Priority 3 Issues

! The Support Manager is notified within 16 hours.

! After 36 hours, the Professional Services Manager is notified.

! After an additional 36 hours, the case is reviewed weekly by the VP of 
Engineering and the VP of Services.

Tracking a Support Case

Blazent Customer Support acknowledges receipt of an issue by sending an e-mail 
confirmation that indicates the reference number of the case. This reference 
number should be used in all communications regarding the issue.

Blazent Customer Support notifies you of changes in case status either by e-mail or 
telephone. You can monitor the status of open issues through the Blazent Support 
web site (http://support.blazent.com).

Closing a Support Case

A support case can be closed when one of the following events occurs:

! The customer is provided with an answer that solves the issue.

! The solution is documented on the Support web site and the customer is 
informed of this.

! The case can be linked to a previously reported and fixed problem.

! Maintenance code or a patch is provided.

! The product documentation is updated.

! It is determined that the issue is not related to Blazent software.

A reasonable workaround is provided and the customer agrees that no additional 
work is required.
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Problem Logging Form
Problem Logging Form

This form assists Customer Support in finding solutions to your technical issues. 
Please complete this form before contacting Customer Support.

Contact Information

Customer Name: _________________________________________________

Project Name: ___________________________________________________

Partner/Integrator Name (if applicable): _______________________________

Contact Name: __________________________________________________

Contact Job Title: ________________________________________________

Telephone Number: ______________________________________________

E-mail Address: __________________________________________________

System Information

Blazent product/version:________________________________________

Hardware type/model:____________________________________________

Operating system/version:_________________________________________

Affected application/component:____________________________________

Level of usage:__________________________________________________
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Chapter C: Technical Support
Problem Description

What command or statement is being used? Is this the first time this operation has 
been attempted?

What are the expected results?

What are the actual results? (Please include the exact error number and message 
text.)

Is this problem reproducible? If so, please provide a reproducible test case that 
includes the specific syntax that causes the problem.

Is this the first time the problem has occurred? 
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Problem Logging Form
When was the last time that this command/statement was successful? What has 
changed since the command/statement was last successful?

If the problem does not occur every time, under what conditions does the problem 
not occur?

Is there any software running on the system which may be conflicting with Blazent 
Software?

What steps have you taken to troubleshoot the problem? (For example, have you 
checked environment variables or file and directory permissions?)
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Chapter C: Technical Support
Problem Log Sheet

Blazent Contact_____________Date____________Time____________

Your Name__________________Case #___________Priority__________

Product_______________________Version________________________

Problem Description

Include error messages, text of error, and so on. When does the problem occur?

Problem Resolution

For the purpose of reference (in case the problem occurs again in the future) 
describe how it was resolved. Include a brief description of the steps taken to 
resolve it.
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Index: C
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saving reports 111

Standard Reports 109
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toolbar 104
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Blazent Collectors 9

configuring 55

Blazent Discovery 7

configuring 64

Blazent Intelligence Platform 7

Blazent IT Intelligence Software
documentation 1

overview 5

Blazent Software Catalog 8

import wizard 16

Blazent technical support 3

BlazentTime clientconfig command 60

bootstrap.xml 55

format 64

Browse sequences, online help 122

bzbs_run_diagnostics.bat 54

bzc_create_db.sql 125

bzc_data_cleansing file 38

bzc_diagnostics.lst 54

bzc_manufacturers table 38

BZUpdate clientconfig command 63

bzw_create_db.sql 125
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C
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import wizard 16
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hardware 14, 19
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cdel clientconfig argument 60, 61
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Chains, task 23
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performance tuning 85
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status 15

troubleshooting 137

Collectors. See Blazent Collectors.
Column headers, merging 114
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Data Warehouse only 82

physical tables 85

tablespace sizing 74

setting array size for 70

Database server
performance tuning 70

Solaris 72

Windows 71

Databases
Analytics Server metadata 9

archiving 99

Collection 8

Data Integration Services metadata 9

Data Warehouse 9

exporting 99

importing 100

data_cleansing task chain 24, 27

data_migration_collection task chain 28

data_migration_warehouse task chain 28

DBA Studio, Oracle 13, 53

DB_block_buffers parameter 71

DB_block_size parameter 71

delay clientconfig argument 63

department table 39

Deployment sizes, Blazent Agent 69

Description rule class 19

dff clientconfig argument 60, 61

Diagnostics, database 13, 54

discovered_assets table 35, 36, 37

DiscoveryCollector clientconfig 
command 62

DiscoveryCollectorConfig.xml 65

DiscoveryCollectorConfig.xml file 64

Discovery. See Blazent Discovery.
discovery_tasks task chain 24, 30

discover_asset_mapping task chain 29

discover_asset_mapping_incremental task 
chain 29

.dmp files 99, 100

Documentation
about 1

viewing online 3

Documents, Blazent Analytics 110

Drilling reports 118

drmp clientconfig argument 62

drrt clientconfig argument 62

dtsp clientconfig argument 62

DT/Engine 23

E

EI command attribute 58

ekt clientconfig argument 61

Embarcadero 9

performance tuning 89

Embarcadero Console 9, 13, 23

log files 27
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Index: L
running remotely 23

employee_positions table 39

emt clientconfig argument 61

emut clientconfig argument 62

Enabled command attribute 58

Enterprise Manager Console, Oracle 13

EnvironmentVariableCollector 
clientconfig command 61

eput clientconfig argument 62

esut clientconfig argument 62

Execution history, task and task chain 26

Exporting databases 99

F

Filtering reports 117

flimit clientconfig argument 63

Format, report 113

Friendly Name rule class 19

G

Graphs, report 113

Grids, report 113

Guest user, Blazent Analytics 102

H

Hardware Categorization area, Blazent 
Administration 14, 19

HardwareInventoryCollector clientconfig 
command 59

hardware_categorization task chain 30

hardware_categorization_incremental task 
chain 30

hardware_entries table 39

hardware_items table 35, 40

Headers, merging column 114

Help Desk, Blazent 10

Help, Blazent Analytics online 120

History List, Blazent Analytics 107

History, task and task chain execution 26

HRMS integration 9

I

Import wizard, software catalog 16

overview 16

Importing databases 100

Index, online help 121

initialize task 37

initialize_all_tasks task chain 23, 31

initialize_db task chain 32

Installation Guide, about 2

Installing
Pentium 4 issues 133

with terminal services 133

Integration, data 9

Intelligence Platform. See Blazent 
Intelligence Platform.

ip-locations.csv file 13, 38, 44

ip_location_mapping task 37

ip_location_mapping_incremental 
task 37

ip_loc_mapping task chain 31

ip_loc_mapping_incremental task 
chain 32

isdsi clientconfig argument 60

L

l clientconfig argument 59

Large icons, Blazent Analytics 105
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lfs clientconfig argument 59

List view, Blazent Analytics 105

load_asset_filters task 37

load_cleansing_filters task 38

load_hw_filters task 38

load_ip_range task 38

load_manufacturer_filters task 38

local clientconfig argument 61

locations table 40

Log files, Embarcadero Console 27

LogonModule clientconfig command 59

M

machines table 40

machine_categories table 40

machine_category_map table 39, 40

machine_info table 39, 40

Manufacturer rule class 19

Mapping
IP ranges and locations 44

servers 42

users 43

map_servers task 39

map_users task 39

Memory requirements, Oracle 9i 71

Merging column headers 114

MicroStrategy 9

performance tuning 94

troubleshooting 135

MicroStrategy Desktop 9, 13, 54

migrate_departments task 39

migrate_dw_disk_storage_util_month 
task 39

migrate_dw_sw_util_ month task 39

migrate_dw_sw_util_day task 39

migrate_dw_sw_util_hour task 39

migrate_employee_positions task 39

migrate_hardware_entries task 39

migrate_hardware_items task 40

migrate_locations task 40

migrate_machines task 40

migrate_machine_categories task 40

migrate_machine_categories_map 
task 40

migrate_machine_info task 40

migrate_os_entries task 40

migrate_os_families task 40

migrate_personnel_status task 40

migrate_software_entries task 40

migrate_software_items task 40

migrate_software_licenses_purchased 
task 40

migrate_sw_package_items task 40

migrate_users task 40

migrate_user_machines task 40

migrate_user_machine_profiles task 40

migrate_user_sessions task 40

My Reports folder, Blazent Analytics 106

My Subscriptions, Blazent Analytics 106

N

Name command attribute 58

Navigating online help 122

NMAP utility 7

nmap_port_list DiscoveryCollectorConfig 
parameter 67

O

o clientconfig argument 63

Online help, Blazent Analytics 120

about 2

help viewer window 120

toolbar 121

Opening Blazent Analytics 101

Oracle
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Index: R
TNS No Listener error 135

Oracle DBA Studio 13, 53

Oracle Enterprise Manager Console 13

Oracle performance tuning guidelines 70

Solaris 72

Windows 71

Oracle services 134

Oracle 9i memory requirements 71

OSCleansing.xml file 45

OsCleansing.xml file 13

os_entries table 40

os_families table 40

Outline mode, report 115

P

PackageInventoryCollector clientconfig 
command 60

Page-by area 115, 118

PCs, Blazent 10

Pentium 4 installation issues 133

Performance tuning 69

Analytics server 90

machine parameters 90

MicroStrategy parameters 94

web server parameters 95

Collection server 85

application parameters 87

machine parameters 86

Data Integration Services 89

database instances 73

Collection database only 79

combined 75

Data Warehouse only 82

physical tables 85

tablespace sizing 74

database server 70

Solaris 72

Windows 71

personnel_status table 40

Physical address extension setting 71

Pivot buttons 115, 117

poll_ip DiscoveryCollectorConfig 
parameter 67

post clientconfig argument 63

PowerUpdate 7

troubleshooting 137

PowerUpdate Controller 13, 54

Preferences, Blazent Analytics 108

Problem identification worksheets 157

Problem log sheets 160

purgeUtilDataHourly task 24, 41, 98

purgeUtilDataMonthly task 24, 41, 98

Q

Quick search box, Blazent Analytics 104

R

RASync command attribute 58

Related Topics buttons, online help 122

reload task 41

Report Builder, Blazent Analytics 106

Report status, Blazent Analytics 107

Report Wizard, Blazent Analytics 106

Reports, Blazent Analytics 10, 108, 109, 
110

background colors 114

data manipulation 115

displaying totals 120

drilling 118

executing 110

filtering 117

format 113

grids and graphs 113

outline mode 115

Page-by area 115, 118

saving 111
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Index: T
sorting 116

subscribing to 112

resend clientconfig argument 59

resynch clientconfig argument 61

Rule classes 19

Rules, categorization 14

S

s clientconfig argument 59, 63

Saving Blazent Analytics reports 111

scan_ip_details DiscoveryCollectorConfig 
parameter 67

scan_wait_time DiscoveryCollectorConfig 
parameter 68

scdsi clientconfig argument 60

scheduled_tasks task chain 23, 32, 43, 44, 
45

Scheduling tasks and task chains 26

scs clientconfig argument 60

Search box, Blazent Analytics 104

Searching online help 121, 122

Server Status area, Blazent 
Administration 14, 15

Servers
Analytics 9

Blazent 10

Collection 8

servers.csv file 13, 34, 39, 42

server_mapping task chain 33

Services, Oracle 134

simultaneous_num_ip_poll 
DiscoveryCollectorConfig 
parameter 68

Size of deployment, Blazent Agent 69

SMS 7

snmp_poll_flag 
DiscoveryCollectorConfig 
parameter 67

socket_num_retries 
DiscoveryCollectorConfig 
parameter 67

socket_timeout DiscoveryCollectorConfig 
parameter 67

Software catalog import wizard 14

overview 16

Software Catalog, Blazent 8

import wizard 16

Software categorization 19

Software distribution software 7

Software License Management area, 
Blazent Administration 14, 18

Software utilization tracking 14

SoftwareInventoryCollector clientconfig 
command 60

software_entries table 40

software_items table 37, 40

software_licenses_purchased table 40

Sorting report data 116

Standard Reports, Blazent Analytics 109

Subscribing to reports 112

Subscriptions, Blazent Analytics 106

Support, technical 3, 149

problem identification worksheets 157

problem log sheets 160

suppress clientconfig argument 59

sw_package_items table 36, 40

sync_all task 41

sync_db task chain 33

System architecture 6

diagram 11

T

Tablespaces 125

Tasks and task chains 23

executing 25

scheduling 26

viewing execution history 26

tcs clientconfig argument 60
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Technical support 3, 149

problem identification worksheets 157

problem log sheets 160

Terminal Services
Embarcadero and 23

Terminal services
recommendation 133

Third-party data integration 9

TNS No Listener error, Oracle 135

Toolbar
Blazent Analytics 104

online help 121

Tools, administrative 13

Totals, displaying 120

Tracking, software utilization 14

transmit clientconfig argument 63

Transmitter clientconfig command 63

Troubleshooting
Blazent Agents 139

Collection server 137

PowerUpdate 137

TSI command attribute 58

Tuning, performance 69

Analytics server 90

machine parameters 90

MicroStrategy parameters 94

web server parameters 95

Collection server 85

application parameters 87

machine parameters 86

Data Integration Services 89

database instances 73

Collection database only 79

combined 75

Data Warehouse only 82

physical tables 85

tablespace sizing 74

database server 70

Solaris 72

Windows 71

U

uidsi clientconfig argument 61

um_add_users task chain 33

User preferences, Blazent Analytics 108

users table 40

users.csv file 13, 34, 43

user_machines table 39, 40

user_machine_profiles table 40

user_sessions table 40

Utilities, administrative 13

Utilization Tracking area, Blazent 
Administration 14

Utilization tracking, software 14

UtilizationCollector clientconfig 
command 61

V

version DiscoveryCollectorConfig 
parameter 66

View mode, Blazent Analytics 105

W

Wait page, Blazent Analytics 110

Y

You are here in Blazent Analytics 105
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